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Abstrakt

Tato diplomova prace se zabyva podporou External mode v mikrokontrolérech.
External mode je specialnim komunikaénim mdédem Simulinku pomoci néhoz
muzeme sledovat a Fidit pribéh simulace v Simulinku, i kdyz je vypoCet modelu

spustén na mikrokontroléru.

V praci jsou popsany moznosti vyuziti External Mode pfi navrhu fidiciho
systému, vytvofeni podpory pro MCU, popis architektury a komunikacniho
protokolu External Mode. External Mode podporuje komunikaci prostrednictvim
sériové linky RS-232, ktera byla pouzita pfi portovani podpory na mikrokontrolér
56F8367. Jadrem prace je vytvoreni podpory External Mode na mikrokontrolér
prostfednictvim komunikace po sbérnici CAN. V zavéru prace je nastinéna
moznost podpory jiného komunikacniho protokolu (JTAG/OnCE) pro External
Mode jako podklad pro dalSi projekt.
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Abstract

This thesis deals with the support of External Mode in microcontrollers. External
mode is a special mode of communication with Simulink that allows us to monitor
and control the course of simulation in Simulink, even if the calculation model is

executed on a microcontroller.

The thesis describes the possibility of using External Mode in the design of the
control system, build support for MCU, describes architecture and communication
protocol of the External Mode. External Mode supports communication via serial
RS-232, which was ported on 56F8367 microcontroller. The core work is to build
support for External Mode to microcontroller using communication via CAN bus.
The support of the External Mode via different communication protocol
(JTAG/ONCE) is outlined in the end of the work. This description is intended to be

basic for the next project.
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Kapitola 1

1 Uvod

Tato diplomova prace se zabyva vytvofenim podpory External Mode
v mikrokontrolérech. External Mode definuje softwarové moznosti komunikacniho
spojeni mezi modelem v Simulinku a kddem modelu, ktery je spustén na cilovém

hardwaru.

V dnesni dobé pfi navrhu a vyvoji kazdého regulacniho systému je potfeba
kontrolovat spravnost fidiciho algoritmu a moznost rychlé zmény nastaveni
parametri (regulatoru). V zakladni fazi vyvoje je softwarovou simulaci ovéfena
zakladni spravnost navrhu algoritmu na modelu soustavy. V dalSim kroku navrhu

regulacniho systému je jiz fidici algoritmus pfimo testovan na fyzickém hardwaru.

Ridici algoritmus je namodelovan v Simulinku ve formé& blokového schématu.
Z tohoto blokového schématu je mozné nastrojem RTW (Real Time Workshop) [1]
vygenerovat analogicky model, ktery je vyjadien ve formé zdrojového kédu
nejCastéji v jazyce C. Vygenerovany kod Fidiciho algoritmu je mozné spustit na

fyzickém hardwaru. Tento navrh je mozné testovat na modelu soustavy, ktera
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muze byt spusténa na simulatoru nebo na realné soustavé.

V této fazi navrhu se jiz vyuziva podpory External Mode. Pomoci External Mode
muzeme ovladat vypocet algoritmu na fyzickém HW pfimo ze Simulinku. Dale
mulzeme monitorovat a zaznamenavat jednotlivé vystupy subsystému algoritmu a
pfimo je zobrazovat v modelu v Simulinku. To vSe je mozné provadét, i pokud je
algoritmus spustény, vSe probiha v realném c&ase. DalSi nepostradatelnou
vlastnosti pfi vyvoji algoritmu je zména parametri. Pokud jsou zménény néjaké
parametry modelu v Simulinku, jsou nahrany pomoci External Mode do
vykonavaného algoritmu na fyzickém HW. VSe je provadéno v realném Case za

béhu algoritmu, bez nutnosti nového kompilovani algoritmu.

Cilem této diplomové prace je implementace podpory External Mode pro
mikrokontrolér 56F8367. External Mode podporuje komunikaci po sériové lince
RS- 232, ktera bude naportovana na pouzity mikrokontrolér. Hlavnim cilem
diplomové prace bude rozSifeni External Mode o komunikaci prostfednictvim
sbérnice CAN. Tato Cast bude obsahovat analyzu funkce External Mode. Dale
bude implementovana podpora pro komunikaci po sbérnici CAN, ktera bude
vychazet z podporované komunikace po sériové lince RS-232. V dalSi ¢asti prace
bude ovérfeni vykonovych vlastnosti vytvofené komunikace po sbérnici CAN.
V zavéru prace budou analyzovany moznosti pouziti JTAG komunikace v External
Mode. Prace tim bude ukazovat nutné pozadavky, které musi byt spinény pro

implementaci jiného komunikacniho protokolu.

Popis problematiky External Mode vCetné jeho pouziti a popisu architektury je
obsahem kapitoly 2. Kapitola 3 popisuje portovani sériové podpory External Mode
na mikrokontrolér 56F8367. Implementace podpory pro komunikaci po sbérnici
CAN je popsano v kapitole 4. Soucasti této kapitoly je vytvofeni demonstracni
ulohy a ovéfeni vykonovych parametrd. Zaroven tato kapitola uvadi postup pro
implementaci jiného komunikacniho protokolu. Kapitola 5 naznacuje moznosti

implementace JTAG komunikace pro External Mode.



Kapitola 2

2 External Mode

External Mode [3] je specialnim komunikaCnim modem podporovanym
v Simulinku, pomoci néhoz muzeme spoustét a sledovat vypoclet simulaci na

externim procesoru v realném case.

External Mode obsahuje dva separované systémy host a target, ktefi mezi
sebou komunikuji pomoci komunikaéniho protokolu. Host je pocita¢ na kterém je
spustén Matlab se Simulinkem, ve kterém je navrzen algoritmus Fidiciho systému
(model). Target je pocita, na kterém je spustén vygenerovany kod z modelu

vytvofeném v Simulinku.

External Mode je zaloZzen na client/server architektufe, kde Simulink je client a
target je server. Host (Simulink) odesila zpravy se zadosti na target jako je zména
parametrd nebo upload dat. Target pfi vykonavani spusténého algoritmu

zpracovava pozadavky a odesila zpét vysledky do Simulinku.

Hlavni prednosti External Mode:

e Zména a ladéni parametrd v realném c¢ase. Pokud jsou
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v External Mode zménény parametry v blokovém diagramu
v Simulinku, okamzité jsou odeslany do spusténého programu na
targetu. To pfina8i mnoho vyhod, neni nutné znova kompilovat
program a pfinasi rychlé ladéni parametru.

e Zobrazovani a logovani vystupl v kterémkoliv bloku systému i
podsystému v Simulinku. Tim muzeme monitorovat vystupy, i kdyz
jsou tyto hodnoty vypoCivany na targetu, bez nutnosti psani
specialniho kédu pro monitorovani. Mizou se definovat podminky,
za kterych jsou data odesilana z targetu do Simulinku. Podminky pro
odesilani dat muzou byt napfiklad, pokud vybrany signal protina nulu
v kladném (zaporném) sméru nebo manualni spousténi.

Zakladem External Mode je komunikacni kanal mezi Simulinkem a kdédem
spusténém na targetu. Tento kanal je vytvofen na nizkourovhové komunikacCni
vrstvé, ktera zajistuje vysilani a pfijimani zprav. Simulink i kéd vygenerovany
zmodelu je nezavisly na této komunikacni vrstvé, kazda cCast je oddélena
v samostatném modulu. Tato koncepce je vhodna pro rlizné Targety (pojem Target

s velym T je definovan v kapitole 2.1.1.1 ) a uziti riznych komunikacénich vrstev.

2.1 Podpora External Mode na MCU

Pro potfeby simulace je nejCastéji pouzivan simulaéni nastroj Simulink [2],
ve kterém je mozné vytvofit a simulovat model fidiciho algoritmu. Tento model je
mozné simulovat v Simulinku nebo za pomoci External Mode na fyzickém
mikrokontoléru (MCU). Pokud je model spustén na fyzickém mikrokontroléru,
potom jsou vypocCtené vysledky zasilany prostfednictvim External Mode do

Simulinku a zde zobrazovany.

Aby bylo mozné model spoustét na MCU, je nutné pouzit nastroj Real Time
Workshop (RTW), ktery umozni z modelu vygenerovat kod a preloZit ho zvolenym
pfekladacem pro konkrétni MCU. Tim mizeme zajistit, aby vysledny spustitelny

soubor, ktery reprezentujici model mohl byt spustén mimo software Simulinku a to
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dokonce i na jiném pocitaci (hardware) a opera¢nim systému.
21.1. RTW

Tato kapitola popisuje nejjednodusi zpusob pro vygenerovani C koédu z modelu
v Simulinku. Postup generovani kodu je vidét na obrazku 1. Nastrojem RealTime
Workshop [3] je z modelu sample.mdl vytvofen soubor sample.rtw, ktery je spolu
se zvolenym Targetem pomoci Target Language Compileru [4] vygenerovan
vysledny kéd. Target Language Compiler umoznuje ménit strukturu generovaného
External Mode. Vyznam pojmu target a zjiSténi podpory pro External Mode je
popsana v kapitole 2.1.1.1.

2111 Target

sample.mdl

Real-Time
Test > Workshop

¥

L

Signal Builder Scope

[ ¥
I
sample.rtw
targety
Target Language Compiler

¥ [ |
¥
Make file soubor
Vygenerovany kod

Obrazek 1: Generovani kédu ,Prevzato z [4]*

Y

[ ]

Target je objekt Simulinku, kterym je v simulaénim programu reprezentovan
cilovy procesor. Targetem je specifikovan CPU jako je pouzity programovaci jazyk,

pouzity operacni systém nebo tfeba nastroje pro praci s vygenerovanym kodem
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na cilovém hardwaru.

External Mode neni podporovan ve vSech Targetech produkovanych firmou
Mathworks. Zde uvadim nékolik Targetl, které podporuji External Mode: ERT,
GRT, GRT malloc a Tornado Target nebo Real Time Windows Target. Jestli je
External Mode podporovan Ize zjistit dvéma zplUsoby. Prvni z nich je zjisténi
podpory v uZivatelskych pfiruckach. Druhy je zjisténi podpory z hlavicky
systémového TLC souboru. Pokud neni External Mode podporovan, je u

EXTMODE uvedeno no_ext_comm.

2.2 Pouziti a nastaveni External Mode

Tato €ast ukazuje jak pouzit a ovladat External Mode v Simulinku. Také jsou zde

ukazany moznosti, které External Mode nabizi (viz [3]).

2.2.1. Vybér simulace a ovladani z panelu Simulinku

Pro komunikaci s targetem v External Mode je potfeba vybrat v Simulinku volbu
External, aby simulace probihala pomoci External Mode. Existuji dva zpusoby

vybéru typu simulace ten nejjednodusi ukazuje obrazek 2.

=Ty
File Edit W%iew Simulation Format Tools  Help
O Ed&S| sBBBE|[E 422 F i Extemnal Ell e (3 &
Mormal -
Accelerator
/ Fiapid Accelerator

menu vybéru simulagniho médu

Constantt

Ready [100%% [ lode3 v

Obrazek 2: Simulace v External Mode
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Pro pfipojeni k targetu je nutné, aby byl spustén vygenerovany kod. V této fazi
se jesté neprovadi vypocet, ale target pouze Ceka na startovaci zpravu k pripojeni
od Simulinku. K targetu se mizeme pfipojit volbou v Simulinku v menu Simulation
-> Connect to Target nebo pomoci ikony (Connect to Target), ktera je umisténa
vlevo od menu vybéru simulaéniho modu (viz obrazek 3). V této fazi je tlacitko

start rtw kodu neaktivni, protoze jesté neni navazana komunikace s targetem.

=]pokus =1o] =]

File Edit Wiew Simulation Format Tools  Help

DleE&| tEmRes a2 r Fle | [Eema Sl Ee @
¥
\ pfipojeni k targetu

startistop rtw kédu na
targetu

Constant

Constant1

Ready [100°% |odes v

Obrazek 3: Pripojeni k targetu

Po uspésném pfipojeni k targetu je spustén vypocCet kddu modelu. Jestli je host
k targetu spravné pfipojen pozname zmeénou stavu z Ready na External v levo
dole v okné modelu nebo pokud je aktivni tlaCitko start real-time code

(viz obrazek 4).
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_iBi

File Edit Wiew Simulation Format Tools Help

DS HSE| s ER[e=t (22> TF [fee ZIEESE| 6

Scope2 Scopeld Scoped

Scopel

Constantt Constant2

External [100% (1] [T=0.000 [FixedStepDiscrete 4
Obrazek 4: Spusténi simulace

Spusténi kodu na targetu muzeme provést ze Simulinku volbou Simulation ->
Start Real-time Code nebo pomoci ikony start real-time code. Pokud je kod na
targetu spustén, zobrazi se misto ikony Start real-time code ikona Stop real-time
code. Dale si mizeme ve spodni listé okna modelu vS§imnout spusténi Casu

simulace (viz obrazek 4).

Zastaveni simulace je mozné provést z menu Simulation -> Stop Real-time
Code nebo stisknutim tlaCitka Stop real-time code, host odeSle na target pfikaz
k zastaveni vykonavani programu a odpoji se od targetu. Po stisku tlaCitka
Disconnect from target odeSle host zpravu na ukonceni spojeni a odpoji se od

targetu, i kdyz je na ném vykonavan program (viz obrazek 4).

2.2.2. Ridici panel External Mode

Ridici panel External Mode (viz obrazek 5) zajistuje centralni ovladani External
Mode. V tomto panelu muzeme zménit rlzné nastaveni, které External Mode
nabizi. Zde jsou shrnuty hlavni mozZnosti:

e Connect/disconnect - host/target pfipojeni a odpojeni.
e Start/Stop Real-time code - spusténi a zastaveni vykonavaného
programu na targetu.

e Arm Trigger — manualni aktivovani/deaktivovani pfijmu dat z targetu.
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e Floating scope — udava jestli a v jakych intervalech se maji pfijimat
data do Floating scope bloku.

e Parameter tuning — zména parametrd v modelu a nasledné na
targetu.

e Configuration — Signal & Triggering nastavuje, které signaly budou
odesilany a nastavuje moznosti spousténi odesilani dat.

e Data Archiving - slouzi k ukladani dat z targetu.

Zména parametrui (tunable parametry)

Pokud neni zvolena volba Batch download, tak se zména hodnoty parametru
v jednotlivém bloku odesSle na target, az potom co potvrdime ulozeni hodnoty v

okné modelu tlaCitkem OK nebo Apply button.

Jestlize je aktivovana volba Batch download, tak se souhrnné zmény v blocich
ukladaji v lokalni paméti modelu. V tomto pfipadé se vSechny zmény odesilaji na
target, az po stisku tlaCitka Download. Na Fidicim panelu (viz obrazek 5) se objevi
napis Parametr changes pending..., ktery je zobrazen tak dlouho, dokud nepfijde
zprava z targetu o uspéSném nahrani parametrd. Tato funkce je vyhodna pokud

potfebujeme zménit vice parametru ve stejny ¢asovy okamzik.

=)} pokus: External Mode Control Panel o ] e |

Connection and triggering

Disconnect Stop Real-Time Code Cancel trigger

Floating scope

[~ Enahle data uploading

Durstion © Euto

Parameter tuning

¥ Eatch download

Parameter changes pending ...

Configuration

Signal & Triggering ... Data Archiving ... |

Help | Close |

Obrazek 5: Zména parametrd
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Nastaveni signalu a spousténi
Pokud v fidicim panelu klikneme na tlacitko Signal & Triggering, zobrazi se nam
dialogové okno (viz obrazek 6), které zobrazuje vSechny signaly z modelu, které je
mozno pomoci External Mode sledovat. Je mozZnost vybrat konkrétni signaly, které
se budou odesilat z targetu do Simulinku. Existuji také bloky, které jsou
nekompatibilni pro External Mode a tyto signaly tu nebudou zobrazeny. Ve spodni
Casti dialogového okna Signal & Triggering se nastavuji moznosti spousténi:
e Source - zdroj pro spousténi muze byt manualni, kdy jsou data
odesilana do Simulinku okamzité, pokud co je aktivni Arm triger. Pokud je
vybran jako zdroj signal, potom jsou data odesilana az po splnéni
podminek (napf. signal prochazi urovni triggeru a definovanym smérem a
dalsi). Signal triggeru se vybere z okna signall a potvrdi se tlaCitkem
Trigger Signal.
e Duration -udava pocet zakladnich krok, ve kterych External Mode odesila
data, potom co byla spInéna podminka triggeru.
e Mode — v normal médu je po splnéni podminky trigger porad aktivni.
Na rozdil od volby one-shot, kdy jsou data odeslana pouze jednou.
e Delay - reprezentuje Casové zpozdéni mezi spusténim triggeru a

odeslanim dat. Toto zpozdéni mize byt kladné i zaporné (pretriggering).

<) pokus: External Signal & Triggering =01
Signal selection
Elock Fath
HT Scope pokus/Scope ;I v Select all
X Scopel pokus/Scopel Clear A |
= on
€ aff
Trigger Signal |
=|  GoTaBlock |
Trigoer
S Isignal ,l Mode: Trigger signal: Port|1 Element:lany
pokus/Scope -
Duration: |1000 Delay: lj :II
-
IV Arm when connecting to target Direction: Irising d Lewvel: ':I Hold-off: h
Revert | Help | Apply | Close |

Obrazek 6: Vybér signalt a spousténi
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Ukladani dat
Pokud v fidicim panelu klikneme na tlaCitko Data archiving zobrazi se nam
dialogové okno (viz obrazek 7), ve kterém mazeme nastavit moznosti archivovani

pFijatych dat z targetu.

=) pokus: External Data Archiving = 0] x|

Data archiving
[+ Enabile archiving

Directory: I [ Increment directary when trigger armed

File: | [™ Incremert file sfter one-shot

Edit Directory Nate... I [~ append file suffis to varishle names

[~ wwrite intermediste results to workspace
Eclt File Mete... |

Rever‘tl Help | Cloze |

Obrazek 7: External Mode uladani dat

Zaskrtnutim volby Enable archiving aktivujeme automatické ukladani dat
v External Mode. Volba Directory specifikuje adresarf kam se maji data ukladat.
File je nazev souboru, kam budou data ukladana. External Mode umoznuje u
nazvu adresare i souboru pfidani koncovky, ktera je zavisla na spusténi triggeru.
Pokud nezaSkrtneme volbu Increment directory when trigger armed nebo
Increment file after one-shot, data jsou stale ukladana do jednoho souboru, tak ze
se prepiSi hodnoty starych dat novymi. V opaéném pfipadé se vytvareji soubory a

adresare, které se liSi koncovkou po kazdém spusténi.

Pouzitelné bloky pro External Mode

V External Mode mulzeme pouzit nasledujici typy blokl pro pfijem a
zobrazovani signalu pfijatych z targetu.
e Floating Scope a Scope bloky
e Spectrum Scope and Vector Scope bloky ze skupiny Signal
Processing Blockset™ product
e Bloky ze skupiny Gauges Blockset™ product
e Zobrazovaci bloky

e Uzivatelské S-Function bloky
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e Moznost vytvoreni vlastniho bloku
e XY Graph bloky

Z blokll je mozné vytvaret systémy a subsystémy. V téchto subsystémech
muazeme vyuzivat funkce External Mode stejné jako u samostatnych blokd. Priklad

subsystém je mozné vidét na obrazku 8.

EU’I—""‘

Sine Wave

theSink

the Sink

Obrazek 8: Moznosti v subsystémech

2.2.3. Vlozené a nevlozené parametry

V této kapitole je popsan rozdil, kdyz je kéd modelu generovan s vlozenymi

parametry a bez vlozenych parametru.
Nevlozené parametry

Pokud je kéd generovany z RTW, tak Ze hodnoty proménnych jsou nahrazeny
symbolickymi jmény parametri namisto konstant, tak se tyto parametry nazyvaji
neviozené. Tato volba se vyuziva pro moznost zmény parametrd

(tunable parametry) v modelu na targetu.

Vlozené parametry

Pokud v nastaveni Real-Time Workshopu (Optimization panel -> Configuration
Parameters) zvolime volbu Inline parameters, potom je generovan kod s
numerickymi hodnotami konstant modelu namisto symbolickych jmen parametra.
V tomto pfipadé je vygenerovany kod jednoduSsSi a vice efektivnéjSi. Moznost
generovani kédu s vlozenymi parametry je pro nas mohem vyhodnéjsi, ale na

druhou stranu nejdou ménit parametry. RTW software nam dovoluje i pfi volbé
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Inline parameters nastavit i nékteré parametry jako proménné (tunable), které lIze
nasledné pomoci External Mode ménit. Toto nastaveni se provadi v nastaveni
Real-Time Workshopu -> Optimization panel -> Configuration Parameters volbou

Configure

2.3 Architektura Klient / Server

External Mode obsahuje zdrojovy kdéd pro implementaci obou stran klienta i
serveru. Komunikace v External Mode je podporovana uzitim TCP/IP nebo sériové
RS-232 komunikace. Dal$i moznosti je implementace vlastniho komunikaéniho
protokolu, protoze Simulink i kod spustény na modelu, jsou nezavisly na
komunikaéni vrstvé. Zdrojovy kéd External Mode s pouzitou komunikacni vrstvou
reprezentuje také samostatny modul. S timto modulem komunikuje host (Simulink)
a target pomoci definovaného rozhrani. V rozhrani je pouze stanoven jednotny
format pfenosu dat, ktery je nezavisly na pouzitém komunikacnim protokolu. Tuto

koncepci je mozné vidét na obrazku 9.

V dalSi ¢asti se budeme zabyvat popisem sériové komunikacni vrstvy, protoze

ta bude vyuzita dale pfi portovani na mikrokontrolér Freescale 56F8367 (viz [5]).

Aby mohla byt komunikace spravné prelozena, je nutné aby server (target) byl
vytvofen s definovanou podminkou EXT_MODE. Podminka EXT-MODE je
definovana v souboru nazev_modelu.mk, tento soubor je vytvofen pfi generovani
kédu z modelu. Tuto podminku je nutné nastavit pro CodeWarrior
(viz kapitola 3.2.1.5).
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Server
----- = 177 VWgenerovany kod
* z modelu

‘ mexFunction ‘

kod externiho modu kod externiho modu

kod komunikagni wrstvy, kod komunikacni wrstwy,

MEX- soubor A ext_swr A

|
v v

Komunikacni kanal
Obrazek 9: Architektura External Mode

Klient a server komunikuji pomoci obousmérného kanalu, kterym se pfenaseji
ramce s daty. Tyto ramce je mozné rozdélit do nékolika skupin Header ,Data nebo
specialni ramce. Header ramce definuji typ ulohy (spusténi, zména parametru,
loggovani dat) a Data ramce vétSinou dopfiuji Header ramce o konkrétni data

(hodnoty signall, nastaveni triggeru a dalsi).

Host vétSinou zasila pozadavky. Target obvykle vykonava tyto pozadavky.
Odpovédi muze byt potvrzeni o vykonani, pozadovana data nebo potvrzeni pfijeti.
Zde je ukazano par pfikladu zprav:

e PfFipojeni / potvrzeni pfipojeni

e Spusténi simulace / potvrzeni spusténi simulace
e Zména parametr( / potvrzeni zmény parametr(
e Odesilani dat / potvrzeni odesilani dat

e Ukonceni simulace / potvrzeni ukonceni simulace
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2.3.1. Pouziti sériového komunikacéniho protokolu

Aby mohl byt pouzit sériovy komunikacni protokol RS-232 v External Mode je

potfeba splnit nasledujici podminky:

2311

Vykonavani programu targetu i hosta na platformé Windows

Ovéreni jestli je pouzit spravny external interface MEX-soubor pro
sériovou komunikaéni vrstvu. Targety podporované firmou MathWorks
specifikuji jméno external interface MEX-souboru v matlabroot/
toolbox/ simulink/simulink/extmode_transports.m. Nazev rozhrani Ize
v tomto souboru ménit, potom se tento nazev zobrazuje v nastaveni
Interface-> Configuration Parameters. Pro sériovou vrstvu se nazev
shoduje s nazvem MEX-souboru serial_win32.

Zkontrolovat jestli v nastaveni makefile je nastaveno propojeni na
spravny soubor pro sériovou podporu serveru, kde jsou definovany
dilezité kompilaéni nastaveni.

Nasledné muzeme vygenerovat kdd

Spusténi programu (koédu) na targetu

Nastaveni v Simulinku volbu simulace External a pfipojeni k targetu

Nastaveni vstupnich parametrid MEX-souboru

Nastaveni vstupnich parametri MEX-souboru se nachazi v Tools->Real-Time

Workshop->QOptions->Configuration Parameters (viz obrazek 10). Zde mlzeme

nastavit parametry, které jsou pfedany External Mode interface MEX-souboru

(ext_win32_comm). Pro sériovou komunikaci Ize nastavit nasledujici parametry:

Verbosity level - nastaveni udrovné vypisu informaci, které jsou
vypisovany na konzoli v Matlabu béhem pfenosu. Lze nastavit
hodnotu 0 pro Zadné informace nebo hodnotu 1 pro detailni vypis.

ID sériového portu — Cislo sériového portu (napfiklad 1 pro COM1).
Prenosova rychlost — Ciselna hodnota prenosové rychlosti, pro
sériovou komunikaci je mozné nastavit (1200, 2400, 4800, 9600,
14400, 19200, 38400, 57600) kbit/s.

Parametry se nastavuji pod polozkou MEX-file arguments a zapisuji se do
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fadku podle poradi jak byly jmenovany (viz obrazek 10).

=1-Real-Time Warkshop | - - !

-~Report — erification
- _omments . .
. Symbols Support software-in-the-loop {SIL) testing
~~Custom Code ™ Create Simulink {5-Function] black I™ Enable portable word sizes
--Debug
~Interface [~ maT-file logging
Code Style

- Templates —Data exchang
- Data Placement /
- Diaka Type Replace nkerface: IExternaI mode LI

men
~Memary Sections Host{Target interfac
=-HOL Coder
- Global Settings Transport layer: Iserial_win32 LI ME¥-file name: ext_serial_win32_comm
-~ Test Bench ~file arguments: I 1,3,57600

~~ED, Tool Scripts

’rMemory managerent ‘

I~ Static memary allocation

,‘). K I Cancel Help | Apply |

Obrazek 10: Nastaveni paramett pro MEX-soubor

2.3.2. Zdrojové soubory External Mode

Host / target

ext_comm.c / ext_svr.c

e T

ext_serial_transport.c/
ext svr serial transport.c
include ext_serial_utils.c

i v

3333,’32.' ext_serial_pkt.c /
-Gekani ext_serial_pkt.c

Y # - pFijem

- vysilani

ext_serial_port.c/
ext_serial_custom_port.c

fyzicky sériovy port
Obrazek 11: Kod External Mode

Na obrazku 11 je vidét struktura zdrojovych souborl na strané hosta i targetu

(zdrojovy soubor hosta / zdrojovy soubor targetu). Obrazek 11 ukazuje pouziti
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souboru pro podporu sériové komunikace, ale pouziti je obdobné pro pouziti

TCP/IP nebo vlastni komunikacni vrstvy.

Pokud jsou zdrojové soubory targetu zcela odliSné od hostu objevuje se

v nazvu zkratka svr (server).

2.3.2.1 Zdrojové soubory pro host

Zdrojové  soubory pro MEX-soubor jsou umistény v  adresafi

vvvvvv

common/ext_comm.c

Tento soubor je jadrem komunikace External Mode. Ext comm.c
komunikuje se Simulinkem pomoci sdilené datové struktury ExternalSim.
Pro komunikaci s targetem pouziva volani funkci komunikacni vrstvy.
Hlavné zajistuje spojeni a odpojeni s targetem, nahrani parametra, ¢ekani

na pfichod zprav od targetu.
common/ext_main.c

Soubor je vstupnim rozhranim do MEX-souboru. Tento soubor je vkladan
do souboru ext comm.c. Simulink vola tento soubor pomoci standartnich

mex funkci.
serial/ext_serial_transport.c

Tento  soubor implementuje funkce pro komunikaéni  vrstvu.
Ext_serial_transport.c vyuziva pomocnych funkci definovanych v souboru
ext_serial_utils.c, ktery je umistén % adresafi

matlabroot/rtw/c/src/ext_mode/serial.
seriallext_serial_utils.c

Obsahuje funkce a datové struktury pro komunikaci, propojeni s
MEX -souborem a generovanym kdédem pro moduly host i target s

jakoukoliv komunikacéni vrstvou.
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common/ext_convert.c and ext_convert.h

Zde jsou obsazeny funkce pro pfevod formatu dat ze Simulinku na target a
naopak. Dale se provadéji jiné konverze dat. Jednou z mnoha dulezitych je
pfevod formatu mezi little endian a big endian. Tyto funkce jsou volany

pomoci ext_comm.c nebo pfimo Simulinkem (pomoci pointeru).
common/extsim.h

Tento soubor definuje datovou strukturu ExternalSim a pfistupova makra.

Tato struktura je vyuzivana pro komunikaci mezi Simulinkem a ext_comm.c.
common/extutil.h

Soubor obsahuje pouze podminky pro kompilaci pfistupovych maker
common/ext_transport.h

Zde jsou definovany funkce, které musi byt implementovany transportni

vrstvou.
Pro implementaci sériového protokolu jsou definovany nasledujici soubory:
serial/lext_serial_pkt.c and ext_serial_pkt.h

Funkce v tomto souboru zajiStuji vkladani pfijatych dat a vybér dat

pro odeslani z objektu sériového paketu

serial/ext_serial_win32_port.c

Je interface mezi programem External Mode a fyzickym sériovym
portem.

2.3.2.2 Zdrojové soubory pro target

Tyto soubory jsou €asti interface na strané serveru a jsou linkovany k vysledné

aplikaci na targetu. Jsou umistény v adresari matlabroot/rtw/c/src/ext_mode/.

common/ext_svr.c
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Ext_svr.c je analogii k ext_comm.c na strané Simulinku, ale vykonava vice
uloh. Je vlastné jako rozhrani mezi soubory External Mode na targetu a
aplikaci (vygenerovanym kdédem). ZajiStuje fadu uloh jako je navazani a
ukon&eni spojeni, zména pfijatych parametri modelu a zapsani téchto
parametri do modelu na targetu, vycteni vypoltenych dat z bufferu a

odeslani téchto dat do Simulinku a mnohé dalsi.
seriallext_svr_serial_transport.c

Tento soubor implementuje funkce transportni vrstvy. Ext_serial_transport.c
pouziva ext_serial_utils.c, ktery je umistén % adresafi
matlabroot/rtw/c/src/ext_mode/serial a obsahuje pomocné komunikacni

funkce.

common/updown.c

Updown.c ovlada vygenerovany model na targetu. Pfi pfijeti novych
parametrt, updown.c nastavuje tyto nové hodnoty do proménnych modelu.
Dale se pouziva pro odesilani dat, obsahuje funkce pro ziskani dat z vstupt

a vystupl modelu a nasledné zapsani téchto dat do vysilaciho zasobniku.

dt_info.h and model.dt

Tyto soubory obsahuiji informace o prevodech datovych typl pro pfistup do
vice typl datovych struktur prostfednictvim rlznych pocitacovych
architektur. Tyto informace se pouzivaji k datovym konverzim mezi host a

target formatem.
common/updown_util.h
Tento soubor obsahuje pouze podminky pro kompilaci pfistupovych maker.
Pro implementaci sériového protokolu jsou definovany nasledujici soubory:
serial/ext_serial_pkt.c and ext_serial_pkt.h

Funkce v tomto souboru zajistuji vkladani pfijatych dat a vybér dat
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pro odeslani z objektu sériového paketu

serial/ext_serial_custom_port.c

Je interface mezi programem External Mode a fyzickym sériovym
portem.
2.3.2.3 DalSi soubory

common/ext_work.c
Tento soubor obsahuje funkce a data specifické pro definovany Target.

common/ext_share.h

Obsahuje definici zprav s jejich Ciselnymi kody a definuje Zadosti od modulu

hosta i targetu.
ext_svr_transport.h

Zde jsou definovany funkce, které musi byt implementovany komunikacni

vrstvou.

2.4 Komunikac€ni protokol External Mode

V External Mode host odesila pozadavky na target. Po pfijeti zpravy target
provadi vykonavani pozadavku. Pfikladem pozadavku je zména parametrd nebo
odeslani dat. Komunikace v External Mode je =zaloZzena na klient/server

architekture, kde klient je Simulink a target je server.

2.4.1. Struktura ramcu

External Mode definuje pfenos dat mezi hlavnim souborem External Mode
(ext_comm.c/ext_svr.c) a hlavnim souborem komunikaéniho protokolu
(ext_transport.c/ext_svr_transport.c) (viz obrazek 11). PfenaSena data muzeme

rozdélit na dva typy ramcu. Prvnim je Header ramec (viz obrazek 12) definuje
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Zzadost (odpovéd), ktera bude provadéna. Druhym je Data ramec (viz obrazek 13),
jehoz typ a velikost dat je uvedena Header ramcem. P¥i pouziti rizné transportni
vrstvy se mlze ménit struktura ramce, vzdy je stejné télo ramce a velikost téla.

Ostatni ¢asti ramce se mohou ménit podle pouzitého komunikacniho protokolu.

Header ramec

hlawitka t&lo paticka

el foe- ool | -—

sstek | t velikost druh velikost K
zacate ¥p téla ru dat ohec
Obrazek 12: Format Header ramce
Data ramec

hlavicka teélo paticka

Lt e[t > -y—
zacatek | typ "’el!g::ﬂ data konec

Obrazek 13: Format Data ramce
Popis jednotlivych poli ramcu:

e zacCatek — zacCatek ramce, pouziti zavisi na zvoleném komunikaénim

protokolu. Pro sériovou komunikacni vrstvu je definovana velikost 2B (7E
7E)

e typ - definice typu ramce, pouziti zavisi na zvoleném komunikacnim
protokolu.

e velikost ramce - tato hodnota udava velikost datové c&asti téla
aktualniho ramce.

e druh — toto pole je pouze v Header ramci a udava druh Header ramce,

vzdy o velikosti 4B, vice informaci o druhu rdmce je popsano v kapitole
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24.2.

e velikost dat - toto pole je pouze v Header ramci a udava velikost dat
(téla) Data ramce, je vzdy 4B. Pokud jeho hodnota neni nulova, tak je po
Header ramci odeslan Data ramec, ve kterém jsou odesilana data
(hodnoty parametrd). Pokud je hodnota pole nulova, tak neni odeslan Data
ramec a jedna se o zadost né&jakych dat ze serveru nebo zménu v

nastaveni.

e data — pole je pouze v Data ramci a v poli data pfenasi informaci, ktera
byla vétSinou specifikovana v Header ramci. Napfiklad pokud je Header
ramcem v poli druh specifikovana €innost EXT_SETPARAM a pole velikost
dat neni nula, tak je odeslan Data ramec. V Poli Data tohoto ramce jsou

hodnoty jednotlivych parametri z modelu.

2.4.2. Druhy ramcu

Druhy ramcu jsou definovany v
matlabroot\rtw\c\src\ext_mode\common\ext_share.h. Pofadové ¢Cislo ramce je
uvedené v zavorce v hexadecimalni soustavé. Toto Cislo je udané v Header ramci
osmy byte. Vyznam ramcU ma rlizné pouziti a je mozné je rozdélit do nékolika
skupin.

e ramce k targetu

- ramce pro pripojeni

o EXT_CONNECT (00)

o EXT_DISCONNECT REQUEST (01)

o EXT_DISCONNECT REQUEST NO_FINAL_UPLOAD (02)
o EXT_DISCONNECT_CONFIRMED (03)

- ramce pro nahrani a ziskani parametrt
o EXT_SETPARAM (04)
o EXT_GETPARAMS (05)

- ramce pro upload dat
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EXT_SELECT_SIGNALS (06)
EXT_SELECT_TRIGGER (07)
EXT_ARM_TRIGGER (08)
EXT_CANCEL_LOGGING (09)

ramce pro fizeni modelu

(o]

(0]

(o]

(o]

(o]

EXT_MODEL_START (0A)
EXT_MODEL_STOP (0B)
EXT_MODEL_PAUSE (0C)
EXT_MODEL_STEP (0D)
EXT_MODEL_CONTINUE (0E)

ramce poZadavku dat

(o]

EXT_GET_TIME (0F)

e ramce z targetu

odpovédi

(0]

(o]

(o]

EXT_CONNECT_RESPONSE (10)
EXT_DISCONNECT REQUEST_RESPONSE (11)
EXT_SETPARAM_RESPONSE (12)
EXT_GETPARAMS_RESPONSE(13)
EXT_MODEL_SHUTDOWN (14)
EXT_GET_TIME_RESPONSE (15)
EXT_MODEL_START RESPONSE (16)
EXT_MODEL_PAUSE_RESPONSE (17)
EXT_MODEL_STEP_RESPONSE (18)
EXT_MODEL_CONTINUE_RESPONSE (19)
EXT_UPLOAD LOGGING_DATA (1A)
EXT_SELECT_SIGNALS_RESPONSE (1B)
EXT_SELECT TRIGGER_RESPONSE (1C)
EXT_ARM_TRIGGER RESPONSE (1D)
EXT_CANCEL_LOGGING RESPONSE(1E)
EXT_TERMINATE_LOG_EVENT(1F)

23
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o EXT_TERMINATE_LOG_SESSION(20)

2.4.3. Pouziti a vyznam ramcu pfi komunikaci

Nejdfive je spustén kéd External Mode na targetu, ktery ¢eka az host zasle
startovaci ramec pro vytvoreni spojeni. Tento startovaci ramec je vyvolan volbou
Connect to target (viz kapitola 2.2), tim dojde k odeslani ramce EXT_CONNECT.
Server na to odpovi dvéma ramci. Prvni ramec obsahuje potvrzeni
EXT_CONNECT_RESPONSE. Druha zprava obsahuje checksum a informace o
formatu dat. Po pfijmu druhého ramce Simulink vezme checksum z targetu a
porovna ji s aktualni v modelu ze Simulinku. Simulink si ulozi hodnoty o formatu
dat, aby védél v jakém formatu bude data odesilat a pfijimat. Dale mizou byt

odesilany z hostu dalSi zpravy, které zavisi na konkrétnim nastaveni External
Mode (napf. EXT_SETPARAM,EXT_ARM_TRIGGER, EXT_SELECT_SIGNALS,
EXT_SELECT_TRIGGER, EXT_CANCEL_LOGGING a dalSi (viz obrazek 14).

EXT_CONNECT
< EXT_CONNECT_RESPONSE

EXT_SETPARAM
EXT_SETPARAM_RESPONSE

-«

EXT_SELECT_SIGNALS >
«@EXT_SELECT_SIGNALS_RESPONSE

EXT_CANCEL_LOGGING
Host <@EXT_CANCEL_LOGGING_RESPONSE Target

EXT_SELECT_TRIGGER -
< EXT_SELECT_TRIGGER_RESPONSE

EXT_ARM_TRIGGER
EXT_ARM_TRIGGER_RESPONSE

-

EXT_GET_TIME
¢ EXT_GET_TIME_RESPONSE
Obrazek 14: Inicializace komunikace

Pokud vSe probéhne bez problému je server a host pfipojen. V této fazi host
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zasila zpravy se zadosti o ¢as na targetu (EXT_GET _TIME), target mu zasila
odpovédi na tyto zpravy a Ceka na spusténi simulace modelu
(EXT_MODEL_START). Po pfijmu tohoto ramce target odpovi ramcem
(EXT_MODEL_START_RESPONSE). Target vykonava koéd modelu a zaroven
zpracovava ulohy. Ulohy zpracovavané jsou napriklad pfijimani, odesilani, nahrani

parametru, zjisténi simulacniho ¢asu a dalsi.

Dulezitou Casti je odesilani vypoctenych vystupd modelu do Simulinku ramcem
(EXT_UPLOAD_LOGGING_DATA). Tento ramec je odesilan periodicky, dle
zvolené periody pfi generovani modelu (viz kapitola 3.2.1.4). Pokud bylo pfi
inicializaci nastaveno odesilani dat pomoci triggeru (EXT_ARM_TRIGGER) a jsou
splnény podminky triggeru (EXT_SELECT_ TRIGGER) jsou odesilany signaly
definované pomoci (EXT_SELECT_SIGNALS). Tento pfipad je mozné vidét na
obrazku 15. Jestlize nebylo pfi inicializaci nastaveno odesilani dat
(EXT_ARM_TRIGGER), potom data (signaly) nejsou odesilany a target Ceka na

pfichod tohoto ramce.

EXT_MODEL_START_ o
EXT_MODEL_START RESPONSE

-«

EXT_UPLOAD_LOGGING_DATA

- EXT_UPLOAD_LOGGING_DATA

Host EXT_GET_TIME Target

< EXT-GET_TIME_RESPONSE

<@ EXT_UPLOAD_LOGGING_DATA

EXT_SETPARAM

>

Obrazek 15: Prubéh simulace

Konec simulace je ukonfeno dosahnutim cilového €asu simulace, zaslanim
ukoncovaciho ramce (EXT_DISCONNECT_REQUEST) nebo zastaveni simulace
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(EXT_MODEL_STOP). Target informuje host o ukon&eni vykonavani zpravou
(EXT_DISCONNECT_REQUEST_RESPONSE) a ukonci spojeni s hostem. Host

také ukonCi spojeni a uzavie External Mode.

2.4.3.1 Popis vyznamu ramcu

V této kapitole je popsano pouziti a vyznam jednotlivych ramca pfi komunikaci
mezi Simulinkem a targetem. Sériova komunikace v External Mode mezi hostem a
targem je zaloZena na potvrzeni kazdého doSlého ramce. Kazdy Header a Data

ramec je potvrzen specialnim (ACK) ramcem, coz je mozné vidét na obrazku 16.

Na obrazku 16 si je mozné vSimnout situace, kdy host odesila 2. Header ramec,
tak nedostane hned potvrzeni ACK ramcem. Jestlize ma target k odeslani néjaky
Header nebo Data ramec, nejdfive ho odeSle a poc¢ka na jeho potvrzeni
o doru€eni. Potom az odesila potvrzeni na 2. Header ramec. Tim je zajisténo, Ze
prubézné zasilaji Header nebo Data ramce oba host i target. Tim nikdy nedojde
k tomu, Ze jeden zasila Header nebo Data ramce a ten druhy pouze potvrzuje

prijeti ACK ramcem.

1. Header ramec >
- ACK ramec
1. Data ramec >
ACK ramec
host -« target
2. Header ramec>
<1 Header ramec (odpoved)
ACK ramec -
-« ACKramec (na 2.Headerr.)

Obrazek 16: Priklad sériové komunikace

Specialni ACK ramec

Tento ramec se sklada pouze z hlavicky a patiCky s pevnou délkou 9 byte a
slouzi jako potvrzeni pfijeti Header nebo Data ramce. V sériové komunikaci

v External Mode je definovan nasledné:
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7E 7E 02 00 00 00 00 03 03

Vyznam jednotlivych byte:

e T7E 7E - odpovida 1-2 byte, je pevny zaCatek vSech ramcu, dale uz
tyto byte nebudeme popisovat u dalSich ramcu

e 02 — udava typ ramce (ACK), jinak u ostatnich ramcl je hodnota
01 (normalni ramec)

e 00 00 00 00 — tato podtrzena cCtvefice byte udava velikost datove Casti,
pro ACK ramec je nulova

e 03 03 — stadartné u vSech ramcl stejna hodnota paticky, dale uz tyto

byte nebudeme popisovat u dalSich ramc

2.4.3.2 Inicializace komunikace

Zacatek komunikace zacina inicializaci, kdy target ¢eka na startovaci ramec.
Pribéh inicializace je mozné vidét na obrazku 14, dale je popsan vyznam

jednotlivych byte dulezitych ramcu.
Ramec EXT_CONNECT

Je to prvni ramec od Simulinku, ktery inicializuje spojeni. Je to Data ramec a

ma nasledujici tvar:

7E 7E 01 08 00 00 00 65 78 74 2D 6D 6F 64 65 03 03

e 08 00 00 00 — velikost datové Casti (téla) je 8B

e 6578 74 2D 6D 6F 64 65 - podtrzené datové pole obsahuje hodnoty,

které v ASCII odpovidaji nazvu ext_mode.

Ramec EXT_CONNECT_RESPONSE

Po pfijmu ramce EXT_CONNECT od Simulinku odesle target nasledujici tfi

ramce. Prvni ramec ma format:

7E 7E 01 08 00 00 00 10 00 00 OO 08 00 00 00 03 03
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Tento ramec udava v prvnich 4B datové Ccasti druh ramce
(EXT_CONNECT_RESPONSE) a v druhych podtrzenych 4B udava pocet bitl

v 1B na targetu. Dale jesté timto ramcem Simulink ziska typ endianu na targetu.
Druhy ramec ma tvar:
7E 7E 01 08 00 00 00 10 00 00 00 54 00 00 00 03 03

Tento ramec je Header ramec, druh ramce (EXT_CONNECT_RESPONSE) a
podtrzeny 4B udavaji velikost nasledujiciho Data ramce o velikosti 84 byte
(54 hex.).

Treti ramec informuje o velikosti datovych typu na targetu a ma tvar:

7E 7E 0154 00 00 00 F1 3A62 1F EB BD 94 37 ED 6B 9C 77 DC 10 07 BE 00 00
00 00 01 00 00 00 OE 00 00 00 04 00 00 00 04 00 00 00 01 00 00 00 01 00 00 00
02 00 00 00 02 00 00 00 02 00 00 00 02 00 00 00 01 00 00 00 04 00 00 00 02 00
00 00 02 00 00 00 04 00 00 00 04 00 00 00 03 03

Tento Data ramec ma délku 84B. V prvnich 16B datového pole jsou Ctyfi 4 byte
kontrolni soucty. Dale nasleduje Ctvefice byte, ktera popisuje parametr
intCodeOnly (zda je na targetu pouzit pouze typ integer). Prvni Cd{tvefice
podtrzenych byte udava parametr targetStatus a dalSi Ctvefice byte udava pocet
datovych typl na targetu. V nasem pfipadé 14 typl (OE hex.), takze dalSich

¢trnact Ctvefic byte udava velikost jednotlivych typl na targetu.
Ramec EXT_SET_PARAM
7E 7E 01 08 00 00 00 04 00 00 00 28 00 00 00 03 03
Jedna se o Header ramec, po kterém nasleduje Data ramec o velikosti 40B.

7E 7E 01 28 00 00 00 03 00 00 00 00 00 00 00 01 00 00 OO 00 00 80 3F 00 00 01
00 01 00 00 00 00 00 A0 40 00 00 02 00 01 00 00 00 00 00 A0 41 03 03

Prvni 4B z data pole udavaji poCet parametri, v nasem pfipadé 3. Kazda

podtrzena Ctvefice byte, udava zacatek jednotlivych parametrt a jejich pofadové
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Cislo. Zvyraznéna Ctvefice byte udava Ciselnou hodnotu jednotlivych parametru.

Ramec EXT_SELECT_SIGNALS

Tento ramec je vyuzivan jen pokud existuji tzv. tunable parametry. V pfipadé
nastavenych tunable parametrd je ve vygenerovaném kodu obsazen soubor
model_data.c, kde model je nazev modelu. Vice informaci v kapitole 2.2.2. Prvni
je odeslan Header ramec, ktery udava Ze dalSi odeslany Data ramec bude mit

velikost datove Casti 44B.
7E 7E 01 08 00 00 00 06 00 00 00 2C 00 00 00 03 03
DalSi vyslany ramec od Simulinku je:

7E 7E 01 3C 00 00 00 00 00 0O 00 01 00 00 00 00 00 00 00 01 00 00 00 00 00 00
00 02 00 00 00 00 00 00 00 00 00 00 00 01 00 00 00 00 00 00 00 00 00 00 00 01
00 00 00 01 00 00 00 00 00 00 00 €4 8C 00 00 03 03

Podtrzené 4 byte je hodnota bufferu na targetu, o jehoz alokaci Simulink zada.
Simulink zada o alokaci bufferu velikosti 36036 byte. ProtoZe velikost paméti na
pouzitém procesoru je mensi, musela byt modifikovana funkce UploadLoginfolnit
v souboru updown.c. Upravou je funkci UploadBuflnit pfedana hodnota 2048B

predstavujici velikost bufferu vice v souboru updown.c.

2.4.3.3 Prubéh komunikace

Uspé&sna inicializace mezi Simulinkem a targetem se projevi aktivovanim ikony
Start real-time code (viz kapitola 2.2.1). V této fazi Ceka target na ramec
EXT_MODEL_START, potvrzeni odesle ramcem
EXT_MODEL_START_RESPONSE, kterym je spustén vypoCet modelu na
targetu. Od této doby je spustén vypolet na targetu a podle zvolené periody
vypoCtu, jsou odesilany vypocCtené hodnoty z targetu ramcem
EXT_UPLOAD_LOGGING_DATA (pokud jsou aktivovany podminky triggeru a je
povolen upload). Kazdy pfijaty ramec je potvrzen ACK ramcem. Mezitim Simulink
zada ramcem EXT_GET_TIME aktualni ¢as simulace, pokud nedostane odpovéd

od targetu pozastavi se zobrazovani simulace, bez chybové hlasky a dale Ceka
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dokud nepfijme ramec s odpovédi (EXT_GET_TIME_RESPONSE). Nasledné
muaze Simulink zasilat libovolné zadosti na target (dle zadosti uzivatele nebo béhu

simulace). Pribéh je mozné vidét na obrazku 15.
Ramec EXT_UPLOAD_LOGGING_DATA

7E 7E 01 30 00 00 00 1A 00 00 00 28 00 00 00 01 00 00 00 00 00 00 00 00 00 00
00 CD CC 4C 3E 00 00 00 00 /00 00 80 3f 00 00 10 41 00 00 20 41 00 00 f0 41
0000 48 42 03 03

Tento rame je typu Data o velikosti téla ramce 48B (30 hex). Prvni modfe
podtrzena Ctvefice byte udava typ ramce EXT_UPLOAD_LOGGING_DATA (1A).
Nasleduje popis jednotlivych dllezitych byte:
28 00 00 00 — udava velikost byte, které budou nasledovat. Tato velikost
zaroven udava pocet pfenasenych hodnot signald.

CD CC 4C 3E - v této Ctverici byte je pfenasen €as simulace

Dale od Cerveného lomitka nasleduje pfenos hodnot jednotlivych signald, které
byly poZzadovany od hosta. Kazda Ctvefice byte udava hodnotu jedoho signalu
Tento pfipad ukazuje pfenos péti signall. Ramec se zvétSuje s kazdym signalem o
4B.
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3 Portovani podpory External Mode pro
MCU s komunikaci po RS-232

Cilem této kapitoly je naportovat sériovou RS-232 komunikaci External Mode na
mikropocitaC Freescale 56F8367. Tato kapitola vychazi z diplomové prace
Processor In the Loop simulace [6], kde byl External Mode pouzit pro PEERT
Target.

3.1 Postup portovani transportni vrstvy

Pro External Mode je podporovana sériova komunikace RS-232 pro win32
aplikace, proto je nutné modifikovat zdrojové soubory na strané targetu pro 16-bit

mikrokontrolér (MCU) nasledujicim zpusobem:

VSechny zdrojové soubory External Mode (viz obrazek 11) budou principielné

zachovany. Bude nutné vytvofit novy soubor ext serial_port.c, ve kterém budou

31
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implementovany komunikaéni funkce pro sériovou linku na MCU. Sablona pro tyto

funkce je uloZzena

v matlabroot\rtw\c\src\ext_mode\custom\ext_serial_custom_port.c. Jelikoz kdéd

External Mode je 32-bitovy a vygenerovany koéd na targetu 16-bitovy bylo nutné
modifikovat nékteré soubory a funkce. Tyto modifikace jsou popsany v kapitole
3.2.3.

3.2 Mikrokontrolér Freescalle 56F8367

MC56F8367EVM je konstruovana jako vSestranna vyvojova deska s
procesorem 56F8367, umoznujici vytvofit programové a hardwarové produkty
v realném Case.. Vykon 16- bitovych procesort 56F8367 v kombinaci s 128K x 16-
bit externi programovou/datovou statickou paméti RAM (SRAM), 128K x 16- bit
externi data/program SRAM, sériovy RS-232 portem, CAN porty, perifernimi
konektory umoznuje tvorbu rozsahlych aplikaci v realném Case.Vyvojova deska
obsahuje JTAG konektor, ktery se vyuziva pro nahravani a ladeni programu. Vice

informaci o této vyvojové desce muzete nalézt v [5] a [7].

3.2.1. Prace s mikrokontrolérem

Pro praci s mikrokontrolérem 56F8367 je vyuZito vyvojového prostiedi
Metrowerks CodeWarrior s nastrojem Processor Expert. Tyto vyvojové nastroje

jsou podrobné popsany v [8].
3.21.1 Processor Expert (PE)

Processor Expert je nastroj podporujici mikrokontroléry Freescale urCené pro
rychly vyvoj aplikaci s vyuzitim programovaciho jazyka C. PE ma k dispozici
informace o procesorech a jejich periferiich obsazenych v tzv. Embedded Beans
(Bean), proto je mozné provadét nastaveni i pokud neni jesté fyzicky k dispozici
samotny procesor. Podle téchto beanu PE generuje kéd s vyuzitim nastaveni

hardwarovych vlastnosti procesoru.
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Nastaveni jednotlivych beanu je velmi jednoduché diky grafickému
uzivatelskému rozhrani. Bean je tvoren vlastnostmi (properties), metodami

(methods) a udalostmi (events), coz je vidét na obrazku 17.

Pomoci vlastnosti se nastavi parametry hadware bez konkrétni znalosti detail(
procesoru a jeho registri. VSechna nastaveni se nechaji kdykoliv ménit v pfipadé
zmény zapojeni vystupnich periferii. Metody umoznuji uZivatelsky pfistup
k periferiim. Tyto metody se nechaji vkladat pfimo do uzivatelského kédu. Diky
udalostem od jednotlivych periferii, mizeme okamzité reagovat na probéhlou

zménu stavu.

3.2.1.2 \Vytvoreni projektu

Ve vyvojovém prostiedi Metrowerks CodeWarrior vybereme novy projekt
(File- >New->DSP56800 New Project Wizard). Po zadani jména projektu
vybereme skupinu a typ mikroprocesoru a jazyk v jakém bude vytvofena zakladni
funkce main(). Ve vytvofeném projektu Ize nastavovat vlastnosti procesoru,
pridavat jednotlivé beany (informace o vlastnostech periferie) a pfidavat vlastni

zdrojové soubory. Vice informaci Ize najit v [9].

3.2.1.3 Pridané beany

Pro komunikaci v External Mode po sériové lince je nutné pfidat bean
AS1:Asynchro serial. Na obrazku 17 je vidét pfidani beanu mezi ostatni.
Nastaveni Beanu, pouzité funkce a udalosti, které lze pouzit pro obsluhu
sériového kanalu je vidét na obrazku 17. Pro External Mode vyuzivajici
komunikaci prostfednictvim sériové linky je maximalné mozZné nastavit rychlost
57600 baud.
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oy mr e e
B & Beans ] ".“ Bean Inspector AS1:AsynchroSerial
J@ TI:Timerlnt
= J@ 451 :AzynchroSerial Bean Items Vigibiity Help < Petipheral Iritialization >
# [E BeforeMewSpeed Propertties ]Methods] Events] Eomment]
= [E AfteriNewspeed | Bean name A5
& [El A31_OnErmar | Channel 501 <5010
&7 [E AS1_OnRsChar Interrupt service/event Enabled ha|
& [E OnRsCharExt Bl Settings
B [E A51_0nT=Char F | Parity nione r|none
i [E A51_0OnFulRxBuf Fo | Width g bits |8 bits
BT [E A51_0rFreeT =Buf I+ Stop bit 1 |1
= [B OnBreak FEl SCI output mode Marrnal 4|
= B OnTxComplete - E Receiver Enabled ha|
& [ Enable HE| Transmitter Enabled ha|
& [ Disable Fv| Baud rate 57600 baud | hiigh: 57692, 308 baud
H [M] EnableEwvent F«| Break signal - Disal?led |
= [H DisableEvent F e Wakeu!:u condition Idle !lne wakeup hdl
& [Fl RecvChar : : ;{ans.mltter. out?jut Mot inverted 4|
& [ SendChar Stop in w_alt mode no ha|
& [ RecvBlack = Inlllallzall.or.l i
I: +"| Enabled in init. code yes ha|
& [ SendBlock +*| Events enabled in init. ves ha|
& [A] ClearR=Buf E| CPU clock/speed selection
K [H ClearTxBuf +| High speed mode This bean enabled 2 This bean is enabled
= [[] CharsInR=Buf [ + | Low zpeed mode This bean dizabled 3| This bean is disabled
T [[] GetCharsinFxBuf | Slow speed mode This bean disabled 3| Thiz bean iz disabled
&[] CharsInT xBuf
& [ GetCharsinT <Buf BASIC ADWVAMCED | EXPERT Eean Level: High Level Bean

Obrazek 17: Nastaveni Beanu AS1

Nazev beanu AS1 by mél zustat zachovan, protoze pouzité metody tohoto
beanu jsou pouzity v kédu External Mode. Pro praci byly pouzity nasledujici
metody:

e AS1_RecvChar — precte jeden byte z bufferu sériové linky.

e AS1_SendBlock — metoda odeSle nastaveny pocet byte na sériovou
linku.

e AS1_GetCharsInRxBuf — metoda zjisti poCet byte v pfijimacim

bufferu

Dalsim pfidanym beanem je CasovacC TI1:Timerint. Timto Casovacem bude
nastavena doba, po které se spusti vypoCet algoritmu modelu. Nastaveni se
provadi v zalozce Properties, kde je dllezité nastavit dobu a prioritu pferuseni.
Nastaveni hodnoty pferu$eni je nutné nastavit na hodnotu minimal priority, aby

byla zajisténa bezchybna komunikace mezi Simulinkem a mikrokontrolérem.

3.2.1.4 Pridani zdojovych souborl a nastaveni

Do vytvofeného projektu je potfeba pfidat zdrojové soubory External Mode a
vygenerovaného modelu. Popis zdrojovych souborl External Mode je popsan
v kapitole 2.3.2 .
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Zdrojové soubory External Mode
e ext svrc
e updown.c
e ext work.c
e ext serial_pkt.c
e ext svr_serial_transp.c

e ext_serial PE_port.c
Zdrojové soubory vygenerované z modelu

Popis generovani souborli z modelu v Simulinku je popsano v kapitole 2.1.1
nebo v literatufe [1]. Nazev souboru je vzdy vytvofen z nazvu modelu. Pfidané
soubory do projektu, které byly vygenerovany z modelu s nazvem Pokus jsou vidét
na obrazku 18. Dale jsou popsany hlavni soubory:

e nazev_modelu.c — obsahuje funkce pro inicializaci, spusténi, krok a
ukonceni vypoctu modelu. Dale je zde uvedena perioda spousténi.

e nazev_modelu_data.c — v tomto souboru jsou uloZeny hodnoty
v proménych, které odpovidaji nastavenim jednotlivych blok
v modelu v Simulinku.

e ert_main.c (nazev targetu_main.c) — tento soubor je Sablona, ktera
ukazuje jak volat step() funkci (v nazev_modelu.c). Je zde popsano
volani funkce step() pomoci pferuSeni nebo potfebna nastaveni pro
ulozeni vstupl a vystupl. Nastaveni pferuseni je provedeno

Casovacem TI1:Timerlnt (viz kapitola 3.2.1.3).

Dale je potfeba nastavit cesty pro rlizné jiné soubory, které jsou potfeba pro
funkci External Mode. Tyto cesty se nastavi ve vlastnostech procesoru v zalozce
Build options -> User paths. Pro sériovou komunikaci jsou nastaveny nasledné:

e ..\nazev-modelu_ert_rtw — adresaf, ktery obsahuje kod vygenerovany
z modelu s podporou targetu ERT

e matlabroot\simulink\include

e matlabroot\rtw\c\libsrc

e matlabroot\rtw\c\src\ext_mode\common

e matlabroot\extern\include
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e matlabroot\rtw\c\src

V zélozce Build options je potfeba nastavit velikost zasobniku (Stack size) na
hodnotu 2000B a haldy (Heap size) na 8000B. Tim se predejde problémim s

alokaci paméti na CPU.

' -+ ent_work, oouser

external_mode_mcp l

|ﬂ zdrn external memary j B @ @ %

Files | Link Order | Targets Fracessor Expert |

(= Configurations
(= Operating System
=& CPUs
< @ BEEEE,
# (g CpuSEFE3E7
(g CpuSEFE367
= & Beans
< @@ T Timernt
-+ @ A5T:AsynchroS ernial
= & User Modules
-+ external_mode. c:main
- Everits. cievent
Vs pokus. c:uzer
Vs ert_main. c:uzer
- pokus_data.c:uzer

ey ewt_svICiuser

- updown. ciuser

s ext_zenal_pkt.ciuser

g ext_svwi_serial_transp.couser

- ext_zenal PE_port.couzer
= Generated Modules
= External Modules
= Documentation

# (= PESL

Obrazek 18: PE - pridané uZivatelské
soubory

3.2.1.5 Nastaveni preprocessoru

Aby mohly byt soubory External Mode spravné prelozeny, je nutné nastavit
v CodeWarrioru pfiznak EXT_MODE. V nastaveni v CodeWarrioru je nutné
nastavit flag EXT_MODE na hodnotu 1, to lze zajistit pfikazem #define
EXT_MODE 1. Nastaveni preprocesoru v CodeWarrioru je mozné vidét na

obrazku 19.



KAPITOLA 3 37

i@ sdm external memo ry Settings E]@
|E Target Settings Panels |E C/C++ Preprocessor
= Target _ A - Prefis Test
- Target Settings Hdefine EXT_MODE 1
- Access Paths
- Build Exbras
- File b appings
- Source Trees

- MBER00E Target
=+ Language Settings
- C/C++ Language |...

Sl /C++ Preprocesso
- C/C++ Warnings
- MEBBO0E Assembler |
= Code Generation Source encoding: [A5C1) p I Use prefix test in precompiled headers
- ELF Disazzembler . -
. MEES00E Processor Preproceszing Options
- Global Optimizations ¥ Emit file changes [ Shaow full paths [ Use Hine
—- Linker v Emit #fpragmas [ Keep comments [ Keep whitespace

L MSGBOE Linker  »|

Factary Settings | | Irpart Panel... | E xpart Panel... |

Ok | Cancel | |

Obrazek 19: Nastaveni preprocesoru v CodeWarrioru

3.2.2. Komunikacni funkce na CPU

Tyto komunikacni funkce vyuZzivaji bean Asynchroserial a jeho funkce, které
obsluhuji  fyzicky  sériovy port. Jsou implementovany v  souboru
ext_serial PE port.c, ktery je vytvofen ze Sablony umisténé v souboru
matlabroot\rtw\c\src\ext_mode\custom\ext_serial_custom_port.c V tomto souboru

je nutné implementovat téla nasledujicich funkci:
e ExtSerialPortCreate — vytvofi objekt typu ExtSerialPort. Tento objek slouzi

pro pFistup k fyzickému sériovému portu.

e ExtSerialPortConnect - tato funkce zajiStuje pfipojeni objektu

ExtSerialPort k fyzickému sériovému portu.

e ExtSerialPortDisconnect — funkce odpoji objekt ExtSerialPort od

fyzického sériového portu.
e ExtSerialPortSetData — funkce odesle jeden byte na sériovou linku.
o ExtSerialGetRawChar — pfijme jeden byte ze sériové linky.

e ExtSerialPortDataPending — tato funkce vraci pocCet pfijatych byte

Cekajicich na precteni ze sériové linky.
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3.2.3. Modifikace zdrojovych soubori External Mode

Modifikace soubort transportni vrstvy

Soubor ext_svr_serial_transport.c je hlavni soubor pouzité komunikacni vrstvy
v External Mode. Do tohoto souboru je vioZen soubor ext_serial_utils.c, protoze
byl problém s pfekladem vygenerovaného kédu v CodeWarrioru. Touto upravou

vznikl novy soubor ext_svr_serial_transp.c.
Cekani na prvni ramec od Simulinku

Vygenerovanému kédu External Mode je mozné pfedat vstupni parametry z
prikazové fadky pfi spusténi aplikace. Tim se prfedava informace, zda se ma
aplikace spustit ihned nebo nebo az po pfijmu prvniho ramce. Pfi nahrani

programu v CodeWarrioru, nelze pfi spusténi tyto parametry aplikaci pfedavat.

Proto musela byt modifikovana funkce ExtWaitForStartPktFromHost v souboru

ext_svr_serial_transp.c, vlozenim kodu:
UD -> WaitForStartPkt = 1;

Potom jiz spusténa aplikace pro simulaci v External Mode Ceka na pfijem

prvniho ramce od Simulinku.
Zjisténi velikosti datovych typt

Pfi inicializaci komunikace mezi targetem a hostem je zjisStovana velikost
datovych typu na targetu. Jelikoz kod transportni vrstvy External Mode pro
sériovou linku je 32 — bitovy, tak je nutné upravit ¢asti kodu pro 16 — bitovy

mikroprocesor.

Musel byt zménén kod ve funkci ProcessConnectPkt v souboru ext_svr.c. Byl
zde zakomentovan plvodni pfikaz a pouzita funkce memcpy pro prekopirovani
obsahu paméti, kde jsou ulozZeny velikosti datovych typu.

//(void)memcpy(&tmpBuf[7], dtSizes, sizeof(uint32 T)*nDataTypes);
(void)memcpy(&tmpBuf{7], dtSizes, sizeof(uint T));
(void)memcpy(&tmpBuf[8], dtSizes+1, sizeof(uint T));
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(void)memcpy(&tmpBuf[9], dtSizes+2, sizeof(uint T));

Touto Upravou se jiZz spravné prekopiruji 16 bitové hodnoty dtSizes do 32bitového
bufferu tmpBuf.
3.2.4. Demonstracni uloha

Byla vytvofena demonstracni uloha pro External Mode s pfenosem pomoci
sériové komunikace. Popis potfebnych zmén pfi portovani na mikrokontrolér
56F8367 byly popsany v této kapitole 3. Podrobny popis kroku spusténi
demonstracni ulohy bude popsan v kapitole 4.4.5, ktera se zabyva implementaci
podpory prostfednictvim CAN sbérnice. Tabulka 1 zobrazuje pfehled zdrojovych
soubor(, které musely byt modifikovany. Zdrojové soubory External Mode pro

komunikac¢ni vrstvu v€etné modelu a PE projektu jsou ulozeny na pfilozeném CD

v adresafri external_mode\serial.

ext_sw.c Tyto soubory je nutné prehrat misto soubortl, které jsou
updown.c uloZeny v matlabroot\rtw\c\src\ext_mode\common
ext_serial_ PE_port.c Tyto soubory je nutné prehrat misto soubortl, které jsou
ext_sw_serial_transp.c  |uloZzeny v matlabroot\rtw\c\src\ext_mode\serial

Tabulka 1: Zdojové soubory pro sériovou RS-232 komunikaci



Kapitola 4

4 Implementace podpory External Mode
pro MCU s komunikaci CAN

Cilem této kapitoly je vytvofit podporu komunikace External Mode

prostfednictvim sbérnice CAN.
4.1 Nutné predpoklady implementace

Pro vytvofeni podpory komunikace CAN v External Mode bude nutné zménit
zdrojové soubory komunikacni vrstvy obou stran host i target. Budou vytvoreny
nové soubory pro komunikacni vrstvu CAN z predvytvofenych Sablon. Tyto
soubory budou pojmenovany nazvem komunikace CAN (napf. ext_custom_port.c
bude zménén na ext_can_port.c) Nékteré soubory budou pouze modifikovany

v porovnani se soubory sériové RS-232 komunikacni vrstvy.

Nejvice zmén bude v souborech ext can portc a ext_can _pkt.c

40
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(viz obrazek 11). V téchto souborech jsou funkce, které sestavuji (rozkladaji) data
z ramcu a tyto ramce nasledné odesilaji (pfijimaji) z fyzického portu. Dale jsou zde

provadény dalSi ulohy jako je pfipojeni, odpojeni, Cekani a mnohé dalsi.

Cela implementace podpory komunikace CAN bude rozdélena na dvé
podcasti. V prvni z nich bude popsana modifikace targetu. Jelikoz jiz v kapitole 3
bylo popsano portovani podpory sériové komunikace na mikrokontrolér 56F8367,
bude se tato Cast tykat pouze zmén oproti sériové podpore provedené na MCU.
V druhé podcZasti bude popsana implementace External Mode na strané
Simulinku, ktera se bude skladat z nasledujicich pod&asti:

e Uprava zdrojovych souborti pro komunikaéni protokol CAN
e Prevodnik pro USB-CAN komunikaci

e Tvorba MEX — souboru pro komunikacni vrstvu CAN

e Registrace podpory komunikacniho protokolu v Simulinku

e Demonstra¢ni model a testovani vykonovych parametru

4.2 Sbeérnice CAN

Sbérnice CAN [9] byla navrzena tak, aby umoznila provadét distribuované
fizeni systémua v realném Case s prfenosovou rychlosti az 1Mbit/s a s vysokym
stupniem zabezpeceni pfenosu proti chybam. Jedna se o protokol typu multi-
master, kde kazdy uzel sbérnice mize byt master. Pro fizeni pfistupu k médiu je
pouzita metoda s nahodnym pfistupem a pfiposlechem komunikace, ktera fesi

kolize na zakladé prioritniho rozhodovani.

Zpravy vysilané po sbérnici CAN neobsahuji zadnou informaci o cilovém uzlu a
jsou pfijimany vSemi uzly pfipojenymi ke sbérnici. Kazda zprava je uvozena
identifikatorem, ktery udava vyznam pfenasSené zpravy a jeji prioritu. NejvySsi
prioritu ma zprava s identifikatorem 0. Tim je zajiSténo na sbérnici CAN, Ze pfi
kolizi dvou zprav dostane pfednost zprava s vysSi prioritou. Z identifikatoru je
mozné zjistit ID zpravy a podle toho rozhodnout, jestli ma zpravu dany uzel

pfijimat (Acceptance Filtering).
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Fyzicka vrstva

Fyzicka vrstva definuje jak jsou po sbérnici pfenaseny signaly. Zakladnim
pozadavkem na fyzickém prenosovém médiu protokolu CAN je, aby realizovalo
funkci logického soucinu. Standart protokolu CAN definuje dvé vzajemné
komplementarni hodnoty bitd na sbérnici dominant a recessive. Vysilaji-li vSechny
uzly sbérnice recessive bit, pak je na sbérnici uroven recessive. Pokud alesponi
jeden uzel vysila dominant je na sbérnici urovenn dominant. Pro eliminaci odrazu
na vedeni je nutné, aby byla sbérnice na obou koncich pfizplsobena

zakoncCovacimi odpory o velikosti 120Q). Vice informaci Ize najit v [9].
Datové ramce

Specifikace protokolu CAN definuje Ctyfi typy zprav. Pro External Mode, ktery je
zaloZen na klient/server architekture budeme potfebovat pouze typ zpravy pro
odeslani dat. Tento typ je pro CAN definovan jako datovy ramec (Data frame).
Struktura datového ramce je na obrazku 20 Vyznam jednotlivych €asti dulezitych

pro pouziti pfenosu v External Mode:

Volna Rizeni pristupu Ridici Potvrzeni
§ ﬁmlcﬁ - na sbérnici b‘miormaceb‘ Datova oblast s CRC LT, %
S ientifik: R . _ . Mezera
|GEIIILF!kAIDr Tl g d;:ikta 0 a2 8 datovych bajt 12!:[3 SiC Klonec el
E Zprévy R ] it jelkinf ramce Zprévami
Délka: 1 " 111 4 0aZ64d 15 111 Fi 3

Obrazek 20: Struktura CAN ramce ,Prevzato z [9]“

e Identifikator zpravy (ID) — podle ného se identifikuje zprava na
sbérnici

e Délka dat — udava pocCet prenasSenych datovych byte v ramci,
povolené jsou 0-8 byte.

e Datova oblast — udava datové byte zpravy, maximalné lze odeslat 8

byte.
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4.3 Target

Nutné modifikace pro komunikacni vrstvu CAN jsou Cervené zvyraznény na
obrazku 21.

Klient Server

(oo™ loix
DSHS 4 =8 54 me> 5 [

Vlygenerovany kod

He
‘d z modelu

(=3 = R—

v

mexFunction

kod externiho médu

‘ kéd komunikacni wrstvy

kod exteniho modu
ext_sw
kéd komunikaéni wrstwy *
MEX- soubor fyzicky port CANu

B USB /CAN &
prevodnik
Obrazek 21: Target - zmény souvisejici s novou komunikacni vrstvou CAN

4.3.1.1 Zména ramctl External Mode po sbérnici CAN

Jedna CAN zprava mulze prenasSet maximalné 8 datovych byte. Pokud by byly
pouzity stejné ramce External Mode jako pro sériovou komunikaci, dochazelo by
k nadbyte€nému pfenosu CAN zprav. Struktura ramcu External Mode je popsana
v kapitole 2.4.2 a pouzita struktura ramcu pro sériovou komunikaci
(viz kapitola 2.4.3.1). Ramce External Mode pro CAN komunikaéni vrstvu byly
upraveny (viz obrazek 22) nasledujicim zpusobem:

e Header ramec - tento ramec ma urCenou velikost pfenasenych dat
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Header

(vySrafovana oblast). Ostatni &asti ramce mohou byt modifikovany
(viz kapitola 2.4.2). Ramec byl upraven, aby mohl byt odeslan pomoci dvou
CAN zprav.

Data ramec — tento ramec ma proménou délku pfenasenych byte. Tento
ramec byl zménén v zavislosti na ramci EXT_UPLOAD_LOGGING_DATA,
kterym jsou prenaseny hodnoty vypocitavanych signald na targetu
k Simulinku. Ramec pro pfenos jednoho signalu ma délku 41B, proto byl
upraven zacatek ramce z 2B (7E 7E) na 1B (7E) (viz obrazek 22).
Specialni (ACK) ramec — tento potvrzovaci ramec ma délku 9B, proto byl
stejné zménén zacCatek ramce jako u Header a Data ramce, aby tento

ramec mohl byt odeslan v jedné CAN zpravé.

velikost

Famee zacatek | typ rimce druh velikost dat | konec
RS232| 2B 1B |48 AR AR 2B
can 1B | 1B PAB % B 2B

| 85 (CAN zprava) | 8B (CAN zpréva)

|-'-' '-'—|-'-|' =
Data . . velikost
ramec zacatek | typ FAM ce data konec
RS232| 2B 18 P 48 ABain deikg 2B
CAN |18 | 1B A8 Vit 28

| 8B {CAN zprava) | promény podet CAN Zpray

|‘-"- '-‘—|-'-' L
ACK . velikost
ramec zacatek | typ FAm ce konec
RS232| 2B 1B AR 2B
CAN [18 | 1B P87 ] 2B

‘ 2B (CAN zoréva)

ot -

Obrazek 22: Upravené ramce External Mode pro CAN
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4.3.2. CAN na MCU

Prace ve vyvojovém prostfedi pro mikrokontrolér 56F8367 byla popsana
v kapitole 3.2.1. V této kapitole se budeme zabyvat nastavenim beanu a zménami
pro komunikaci CAN oproti pfedchozi sériové RS-232 komunikaci na pouzitém

mikrokontroléru.

4.3.2.1 FlexCAN interface

Mikroprocesor 56F8367 obsahuje dva FlexCAN interface. Pfi praci je vyuzit
prvni interface FlexCAN #1, jeho schéma vC€etné konektorl je mozno vidét na
obrazku 23. Mikroprocesor vyuziva CAN prevodnik PCA82C250 definovanou
fyzickou vrstvou podle Phillips high-speed s maximalni rychlosti 1.0Mbit/s (viz [7]).

+ ;\GV
MC56F8367 Jt
1K %‘: CAN Transceiver
CAMN1T_TX * TXD 120
CANH AR * 4 CAN #1 Bus
CANL R 3 - 1 Connector
CAN1T_RX RXD
_ J21
PCAB2C250 — {4 Daisy-Chain CAN #1
5 ect
, T Connectar

1 CAN Bus #1
2 Terminator

Obrazek 23: FlexCAN interface ,,Prevzato z [7]*

Pro pfipojeni byl pouzit konektor J20, jeho zapojeni je v tabulce 2. Dale si
muzeme z obrazku v8imnout, Ze propojkou JG13 muzeme pfipojit zakonCovaci

odpor sbérnice o velikosti 120 Q.

Pin Signal Pin Signal
1 nezapojen 2 nezapojen
3 CANL 4 CANH
5 GND 6 nezapojen
7 nezapojen 8 nezapojen
9 nezapojen 10 nezapojen

Tabulka 2: Zapojeni konektoru FlexCAN 1
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4.3.2.2 FlexCAN bean

Pro komunikaci v External Mode postfednictvim CAN sbérnice je nutné pfidat

do projektu bean CAN: CAN7:FreescaleCAN. Nastaveni vlastnosti je Siroké,

vvvvvv

CAN1 obsahuje 16 bufferd pro zpravy, které se mohou nastavit jako vysilaci
nebo pfijimaci. Dale se u jednotlivych bufferd nastavuje typ zprav, které se maiji
prijimat (standard, extendet). Identifikacni Cislo (ID) zpravy se nastavuje pouze u
prijimaciho bufferu. ID odesilané zpravy lze ménit ve funkci pro odeslani.
PreruSeni pro vysilani a pfijem bylo nastaveno se strfedni prioritou na hodnotu
medium priority. Rychlost pfenosu je mozné nastavit pod poloZzkou Bit rate, byla
nastavena na maximalni moznou pro sbérnici CAN na hodnotu 1.0Mbit/s.

Nastaveni beanu CAN1 je vidét na obrazku 24.

Bean Inspector CAN1:FreescaleCAN

Eean Items Visibility Help < Feripheral Initialization »

Properties ] Methods ] Events ] LComment ]

+"| Bean name Caml ~

+"| CAN channel FC ~|FC

Interupt zervice/event Enabled j&

= Settings

Fe| s pin CaAk_F= | AJCAN_Rx

FH+| Fx pin signal

FHe| Tu pin CaAr_Tx | AJCAN_T=

Fe| T pin Signal

F Message bulfers 16 +i=l

| Acceptance mazk for buffer 0-13 1FFFFFFF H|

He| Acceptance mazk far buffer 14 1FFFFFFF H|

| &cceptance mask for buffer 15 1FFFFFFF H|

Fe| Timer spnchronization Dizabled =)

[+ Lowest buffer transmitted first Lowest ID hd

| Debug mode [g=] 2

o | At power save (=] =)

| Loop mode no o2

| Ligtern only mode (=] =)

- El| wWakeup Dizabled =)

[l Timing

e | T timing wizard click to mn tirming wizard -> ... |

F «| Propagation segment a o

H+| Time zegment 1 4 o]

r+| Time segment 2 7 o

v RSJ 1 o]

| Samples per bit One sample hd

Fe| Time quanta per bit

- «| Bit rate 1000 kbit/s === high: 1000 kbit’s
BASIC ADVAMCED | EXPERT Bean Level: High Level Bean

Obrazek 24: Nastaveni beanu CAN1

Jméno beanu musi byt zachovano, protoze je soucasti nazvu metod, které jsou

pouzity ve zdrojovém kodu External Mode.
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Pouzité metody (funkce) beanu CAN1

e CAN1_SendFrame (BufferNum, MessagelD, FrameType, Length, Data,
waitForRTR) — tato funkce odeSle CAN ramec z bufferu (BufferNum) s ID
definovanym v parametru MessagelD. Pocet odesilanych byte udava
parametr Length, na adresu datovych byte ukazuje ukazatel Data. Typ
odesilaného ramce je definovan v FrameType a posledni hodnotou se

nastavuje moznost na ¢ekani potvrzovaciho ramce (waitForRTR).

e CAN1_ReadFrame (BufferNum, MessagelD, FrameType, FrameFormat,
Length, Data) — tato funkce pfijme ramec z bufferu (BufferNum) zpravu s ID
(MessagelD) o délce (Length), data jsou uloZena na adresu ukazatele Data.
Typ pfijimaného ramce je definovan v FrameType a format ramce je uveden
v (FrameFormat). Tato funkce podle zvoleného ID pfijme pouze zpravy se
stejnymi parametry ID a FrameType, ktery jsou definovany v nastaveni

bufferu nebo je mozné je ménit pomoci metod.

e CAN1_GetStateTX (void) — vrati poCet CAN zprav, které Cekaji na

odeslani.

e CAN1_GetStateRX (void) — vrati poCet CAN zprav, které cekaji na
prijeti.

e CAN1_SetAcceptanceCode (BufferNum, ID) — tato metoda nastavi
zvolenému pfijimacimu bufferu ID €islo CAN zpravy, potom tento buffer

pfijima zpravy s timto ID.
Pouzité udalosti (events) beanu CAN1
e CAN1_OnFreeTxBuffer (BufferMask) — udalost je vyvolana, pokud byla

uspésdné odeslana zprava. Pomoci parametru BufferMask lze zjistit, jaky

buffer vyvolal udalost.

e CAN1_OnFullRxBuffer (void) — udalost je vyvolana, pokud je néjaky
nastaveny pfijimaci buffer plny, pomoci masky Ize zjistit, ktery buffer vyvolal

udalost.
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FlexCAN bean obsahuje moznost nastaveni 16 bufferd pro pfijem nebo
odeslani zprav. Prvnich osm buffert (0-7) bylo nastaveno pro pfijem a zbyvajicich

osm pro odesilani (8-15).

PFfi odesilani je ramec External Mode rozdélen po 8B do jednotlivych CAN
zprav. Tyto zpravy jsou odesilany pomoci nastavenych osmi vysilacich buffert.

Jelikoz neni definovana konstantni velikost ramce External Mode, proto je nutné

v v
v v

v v

v v

prijimacimu bufferu je nastaveno ID s hodnotou 200 a dal$im bufferim postupné
vzdy o jedno Cislo vysSi. Pokud je pfijata zprava je nasledné tomuto bufferu
pomoci metody CAN1_SetAcceptanceCode nastaveno ID o jedno vysSi nez je
posledni nastavené pro pfijimaci buffery. Na druhé strané host odesilda CAN

zpravy s rostoucim ID

4.3.2.3 Pridani zdrojovych souboru do projektu PE

Popis pfidani zdrojovych soubort a jind nastaveni jsou popsany v kapitole
3.2.1.4 pro sériovou komunikaci External Mode. Pro novou komunikacni vrstvu
CAN, jsou ze Sablon vytvofeny noveé soubory:

e ext can_pkt.c
e ext_svr_can_transp.c

e ext can_ PE_port.c

Popis modifikaci soubort pro transportni vrstvu CAN bude popsano v kapitole
4.3.3. Nastaveni preprocesoru je stejné jako u sériové komunikace a je popsano
v kapitole 3.2.1.5.
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4.3.3. Zdrojové soubory External Mode target

Nutné zmény v souborech External Mode pfi portovani na mikrokontrolér
56F8367, byly popsany (viz kapitola 3.2.3). Jsou stejné pro jinou komunikacni

vrstvu, protoZe jsou zavislé na typu mikrokontroléru.

V této kapitole budou popsany zmeény, které souvisi se zménou komunikacni
vrstvy na targetu. V kapitole 2.3.2 jsou popsany zdrojové soubory External Mode.
Na obrazku 11, je vidét struktura pouziti jednotlivych souborl pro sériovou
transportni vrstvu. Pro zménu transportni vrstvy je nutné zménit zdrojové soubory

oznacCené v ramecku s popisem soubory komunikacni vrstvy.

Zde je uveden postup pro zménu komunikacéni vrstvy na targetu:

ext_svr_can_transport.c a ext_can_utils.c

Prototypy funkci Ext*, které definuji volani funkci transportni vrstvy jsou
umistény v  matlabroot/rtw/c/src/ext_mode/common/ext_svr_transport.h. Pro
sériovou implementaci jsou umistény v souboru matlabroot/rtw/c/src/
ext_mode/serial/ext_svr_serial_transport.c. Nutné body pro implementaci target
komunikacni vrstvy:

e Uprava Sablony matlabroot/rtw/c/src/ext_mode/custom/

ext_svr_custom_transport.c

o Zména jména souboru transportni vrstvy, byla provedena zména
na ext_svr_can_transport.c

o Implementace tél funkci VISIBLE FUNCTIONS, které vola hlavni
soubor External Mode (ext_svr.c). V télech jednotlivych funkci je
implementovano volani komunikacnich funkci, které pfistupuji k
fyzické vrstvé protokolu. Musime implementovat vSechny funkce
definované v souboru ext_svr_transport.h.

o Definice datové struktury ExtUserData. Pokud tato struktura neni
definovana je vytvorena tato struktura s prazdnym polem.

o Definice volby EXT_BLOCKING, kdy muzeme pouzit spojeni s

targetem jako jedno nebo vicevlaknovou aplikaci.
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e Ze Sablony ext _custom_utils.c pro definovani uzivatelskych symboll a
funkci, byl vytvofen soubor ext _can_utils.c. Pokud jsou tyto funkce
pouzivany pro target, je nutné vlozZit do zdrojového souboru
transportni vrstvy.

e Uprava $ablon makefile pro podporu nové transportni vrstvy. Dalezité
je definovat volbu EXT_MODE.

Komunikace prostfednictvim sériové linky RS-232 a CANu je velmi podobna3,
protoze po sbérnici CAN jsou odesilany zpravy po 8B oproti sériové lince po 1B.
Proto nové vzniklé soubory jsou modifikaci zdrojovych soubort sériové transportni
vrstvy External Mode.

ext_can_PE_port.c

Ze Sablony matlabroot\rtw\c\src\ext_mode\custom\ext_serial_custom_port.c byl
vytvofen soubor ext_can_PE_port.c. V tomto souboru byly vytvofeny komunikacni
funkce vyuzivajici bean CAN1. Metody a udalosti beanu CAN1 obsluhuji fyzicky
CAN port a jsou popsany v kapitole 4.3.2.2. V tomto souboru byly implementovany
téla nasledujicich funkci:

e ExtCanPortSetData — odeSle jeden ramec External Mode na sbérnici.
Tento ramec je odeslan po jednotlivych CAN zpravach po 8 byte. Vice
informaci o struktufre ramce External Mode (viz kapitola 4.3.1.1) a

o odesilani CAN zprav (viz kapitola 4.3.2.2).

e ExtCanGetRawData — Pfijme jeden ramec External Mode. Tento ramec se
muze skladat z vice CAN zprav, tak funkce ¢eka dokud nepfijme kompletni

ramec External Mode.

e ExtCanPortDataPending — Tato funkce vraci poCet CAN zprav Cekajicich

na pfijem ze sbérnice CAN.
ext_can_pkt.c

Tento soubor vznikl ze souboru ext_serial_pkt.c, ktery slouzi jako Sablona. V tomto
souboru jsou hlavné funkce, které zajiStuji sestavovani a rozebirani ramce
External Mode z pfijatych (odeslanych) CAN zprav. CAN zpravy jsou pfijimany a

odeslany pomoci mfunkci definovanych v souboru ext_can_PE_port.c (pro target),
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ext_can_port.c (pro host). Hlavni odliSnosti oproti sériové lince jsou v tom, Ze
ramec External Mode je odesilan (pfijiman) pomoci CAN zprav. CAN zpravy
mohou obsahovat 8 data byte oproti sériové lince, kde je informace posilana po

jednotlivych byte. Zde jsou uvedeny hlavni funkce, které obsahuje tento soubor:

e SetExtCanPacket (ExtCanPacket *pkt, ExtCanPort *portDev) — v této
funkci je vytvofen odesilany ramec External Mode z objektu datového
paketu a nasledné predan funkci ExtCanPortSetData, ktera ho odeSle

na sbérnici.

e GetExtCanPacket (ExtCanPacket *pkt, ExtCanPort *portDev) — po pfijmu
dat, jsou tyto data vkladana do objektu datového paketu. Nejdfive se
dekdduje v hlavicce pocCet datovych byte a nasledné se tyto byte ukladaji

do objektu datového paketu.

4.4 Host

Tato kapitola bude obsahovat popis implementace podpory External Mode
(strana host) pro komunikaci po sbérnici CAN. Aby bylo mozné komunikovat po
sbérnici CAN z PC je pouzit USB-CAN prevodnik. External Mode na strané host

bude komunikovat s driverem USB-CAN pfevodniku.

Implementace podpory External Mode na strané host (Simulinku) bude

obsahovat vice zmén. Hlavni body nasledujich zmén jsou zde popsany:

1. Uprava zdrojovych $ablon External Mode. Hlavni $ablona souboru pro
podporu External Mode je ulozena % adresafri
matlabroot/rtw/c/src/ext_mode/custom/ext_custom transport.c. V  této
Sabloné je potfeba definovat funkce pro volani nové komunikaéni vrstvy

Tuto Sablonu je potfeba zménit nasledujicim zpusobem:

e Pfejmenovani Sablony ext custom_transport.c jménem nové

transportni vrstvy.
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e Zména funkci definovanych v souboru ext _custom_transport.c.jako
je (pfipojeni, odpojeni, odesilani, pfijem, &ekani a definovani
uzivatelskych dat). Pomoci téchto funkci jsou volany funkce
komunikacéni  vrstvy, které jsou definovany v  souboru

ext_custom_port.c (viz obrazek 11).

2. Vytvofeni uzivatelského MEX-souboru uzitim funkce mex z Matlabu, pro

komunikaéni vrstvu CAN, ktera bude vyuzivat USB-CAN pievodnik.

3. Registrovani nové transportni vrstvy External Mode v softwaru

Simulinku.

Nutné zmény pro vytvoreni nové komunikacni vrstvy jsou zobrazeny Cervené na
obrazku 25.

Klient
Registrace komunikacéni wstwy v Simulinku
T T T — — erver
y
i .
Viygenerovany kod
gﬁ z modelu
mexFunction

\ kod externiho modu

kod externino médu kéd komunikagni wstvy

kéd komunikaéni wrstvy ext swr

MEX- soubor

USB USB / CAN &
prevodnik
Obrazek 25: Host - zmény souvisejici s novou transportni vrstvou CAN

Nejdfive bude popsan pfevodnik USB-CAN, protoze pouzitim jeho funkci budou

implementovany téla funkci External Mode pro komunikaci po sbérnici CAN.
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4.4.1. USB-CAN prevodnik

4.4.1.1 Instalace USB-CAN prevodniku

Pro instalaci je nutné dodrZovat postup popsany (viz kapitola 1 v literatufe [10]).
Je nutné nejdfive spustit sotwarovou instalaci a potom az pfipojit fyzicky USB
konektor USB-CAN prevodniku do PC. Po instalaci je mozné ziskat informace o
zafizeni. Tyto informace je mozné nalézt v Start -> Ovladaci panely -> USB-CAN
modul control (viz obrazek 26). Zde je mozné zjistit a nastavit Cislo zafizeni, to je
vhodné k rozlieni v pfipadé, Ze pouzivame vice nainstalovanych prevodnikd na
jednom pocitaci. Dale je mozné nastavit jestli ma byt prevodnik vyuzZivan jednou

nebo vice aplikacemi, debug informace nebo tfeba zjistit verzi driveru.

5 UsB-CaAMNmodul Control - {C) 5¥S TEC electronic GmbH x|

Hardware |Versi0ns| Debugl Llpdatel

" Lizt of connected USB-CAMmodulz on this computer...

Serial Mr. Dewhir. Device Type Firmyware Werzion dre
LISE-CaNmodull 4/4.04 12 |

Change... | Fartz. . | Get Error | Switchall...l About... |

Ok I Starno | FouzEit |
Obrazek 26: USB-CAN informacni panel

4.4.1.2 Pripojeni prevodniku na sbérnici

Pouzity pfevodnik USB-CAN od firmy SYS TEC Elektronic typ 3204000
obsahuje jeden CAN kanal s high-speed vysilatem Philips 82C251. Prevodnik
obsahuje pro pfipojeni na sbérnici CAN konektor DB-9 CAN. Zapojeni pina je

mozné vidét v tabulce 3.
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Tento pouzity typ prevodniku nema pfipojen zakoncCovaci odpor o velikosti
120Q. Proto je nutné pfi pfipojovani prfevodniku ke CAN sbérnici pfidat tento

zakoncovaci odpor. Odpor se pfipojuje mezi piny CANL a CANH.

Pin Signal Pin Signal
1 nezapojen 2 CANL
3 GND 4 nezapojen
5 CAN stinény 6 GND
7 CANH 8 nezapojen
9 VCC

Tabulka 3: Zapojeni pinti CAN konektoru DB-9

4.4.1.3 Softwarova podpora pro Windows

Pri instalaci prevodniku je vytvoren adresar umistény %
C:\Programs_Files\SYSTEC-electronic\USB-CANmodul Utility Disk. V tomto
nainstalovaném adresafi jsou k dispozici demo ulohy, dokumentace a hlavné
soubory (USBCAN32.LIB, USBCAN32.H) a knihovna funkci (USBCAN32.DLL) pro

praci s timto pfevodnikem.

Pro kazdy USB-CAN modul, ktery vyuziva knihovnu DLL jsou generovany ffi

stavy (viz obrazek 27).

| DLL loaded |

I UcanDeinitHardware()

UcanlnitHardware()

UcanDeinitCan()

]

UcanInitCan()

| DLL unloaded |

Obrazek 27: Stavovy diagram softwaru DLL ,Pfezato z [10]*

Po startu aplikace a nacteni DLL pfechazime do prvniho stavu DLL_INIT. V
tomto stavu volanim knihovnich funkci UcanlinitHardware() zménime stav na

HW_INIT. V stavu HW_INIT mizeme volat mnoho funkci, které nastavuji rizné
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moznosti komunikace, ale nelze odesilat (pfijimat) zpravy. Volanim funkce
UcanlinitCan() pfechazime do stavu CAN_INIT. V tomto stavu je jiz mozné posilat

(pfijimat) zpravy.

Zpét se muzeme dostat volanim funkci UcanDeinitCan() do stavu HW_INIT a
dale funkci UcanDeinitHardware() do vychoziho stavu DLL_INIT. V tomto stavu je

teprve mozné ukoncit program.

Pfehled vSech moznych funkci, které Ize pouZzit v jednotlivych stavech popisuje
tabulka 11 v literatufe [10]. Dale budou uvedeny dulezité funkce vcetné popisu,

které byly pouzity pfi implementaci CAN komunikacéni vrstvy.
DLL_INIT

e UcanlnitHardware (*pUcanHandle_p,bDeviceNr_p, fpCallbackFkt_p) —
tato funkce inicializuje USB-CAN modul. V prvnim parametru je definovana
adresa pointeru na handle. V druhém parametru se zadava Cislo USB-CAN
zarizeni (viz obrazek 26). Posledni parametr obsahuje adresu callback

funkce.

e UcanDeinitHardware (UcanHandle p) — opak funkce UcanlnitHardware,

vstupni parametr je handle, ktery byl ziskan pfi inicializaci.
HW_INIT

e UcanlnitCanEx (UcanHandle p,* plnitCanParam_p) — tato funkce
inicializuje CAN interface s nastavenim parametrl a tim pfejde do stavu
CAN_INIT. Prvni parametr je handle ziskany z funkce UcanlnitHardware,
druhym parametrem je ukazatel na adresu struktury, ktera obsahuje

inicializaéni data.

e UcanDeinitCan (UcanHandle_p) — tato funkce se odpoji od CAN
interface, tim pfejde ze stavu CAN_INIT do stavu HW_INIT. Je opakem

funkce UcanlInitCanEx.

e UcanGetStatus (UcanHandle_p,* pStatus_p) — tato funkce vrati chybovy
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stav USB-CAN modulu, vstupni parametr je handle a ukazatel pro ulozeni
chybového stavu. Tato funkce ma vyhodu v tom, Ze po pfecteni chyby ji
vymaze, bez nutnosti volani funkce pro vymazani (reset).

CAN_INIT

e UcanReadCanMsg (UcanHandle p,* pCanMsg_p) — funkce pfecte Can
zpravu z pfijimaciho bufferu. Druhy parametr ukazuje na adresu, kde je

uloZena pfijatd CAN zprava.

e UcanWriteCanMsg (UcanHandle_p,* pCanMsg_p) — funkce odes$le Can
zpravu do vysilaciho bufferu. Druhy parametr ukazuje na adresu struktury,

ktera obsahuje data odesilané CAN zpravy.

e UcanGetMsgPending (UcanHandle_p, bChannel_p, dwFlags p,*
pdwCount_p) — tato funkce vraci poCet CAN zprav, které jsou umistény
v bufferu. Parametr bChannel urCuje, ktery kanal se kontroluje. Parametr
dwFlags p urCuje jaky buffer se bude kontrolovat (vysilaci, pfijimaci).
Posledni parametr je ukazatel na data, kam se uklada pocet Cekajicich

zprav.

Detailni informace o pouzitych funkcich v€etné jejich popisu, definice parametr

nastaveni a navratovych hodnot je popsano (viz kapitola 2.3.2.1 v literatufe [10]).

4.4.2. Zména zdrojovych souboru External Mode (host)

V této kapitole budou popsany zmeény, které souvisi se zménou komunikacni
vrstvy na strané Simulinku (host).Tyto zmény jsou velmi podobné zménam
provedenym na strané targetu pro CAN transportni vrstvu popsanou
v kapitole 4.3.3 V kapitole 2.3.2 jsou popsany zdrojové soubory External Mode. Na
obrazku 11 je vidét struktura pouziti jednotlivych soubori pro sériovou
komunikacéni vrstvu pro CAN je stejna. Pro zménu komunikaéni vrstvy je nutné
zménit zdrojové soubory oznacené v ramecCku s popisem soubory komunikacni

vrstvy.

ext_can_transport.c a ext_can_utils.c
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Prototypy funkci Ext*, které definuji volani funkci transportni vrstvy jsou
umistény v  matlabroot/rtw/c/src/ext_mode/common/ext_svr_transport.h. Pro
sériovou implementaci jsou umistény Vv souboru
matlabroot/rtw/c/src/ext_mode/serial/ext_serial_transport.c. Nutné body pro
implementaci target transportni vrstvy:

e Uprava Sablony matlabroot/rtw/c/src/ext_mode/custom/
ext_custom_transport.c
o Zména jména souboru transpotrni vrstvy, byla provedena zména
na ext_can_transport.c
o Implementace tél funkci VISIBLE FUNCTIONS, které vola hlavni
soubor External Mode (ext_svr.c). V télech jednotlivych funkci je
implementovano volani komunikaénich funkci, které obsluhuji
fyzickou vrstvu protokolu. Musime implementovat vSechny funkce
definované v souboru ext_transport.h.
o Definice datové struktury ExtUserData. Pokud tato struktura neni
definovana je vytvorena tato struktura s prazdnym polem.
o Definice volby EXT_BLOCKING, kdy muzeme pouzit spojeni s
targetem jako jedno nebo vicevlaknovou aplikaci.
e Ze Sablony ext_custom_utils.c pro definovani uzivatelskych symbolu a
funkci, byl vytvofen soubor ext_can_ utils.c.
e Uprava $ablon makefile pro podporu nové transportni vrstvy. Dalezité
je definovat volbu EXT_MODE.

ext_can_port.c

Ze Sablony matlabroot\rtw\c\src\ext_mode\custom\ext_custom_port.c byl
vytvofen soubor ext can_port.c. V tomto souboru byly vytvofeny komunikacni
funkce vyuzivajici funkci USB-CAN prevodniku. Tyto funkce obsluhuji fyzicky CAN
port zminéného pfevodniku a jsou popsany v kapitole 4.4.1.3. V tomto souboru
byly implementovany téla nasledujicich funkci:

e ExtCanPortCreate — vytvori objekt typu ExtCanPort. Tento objek slouzi pro

pristup k fyzickému portu.

e ExtCanPortConnect — tato funkce zajiStuje pfipojeni objektu ExtCanPort
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k fyzickému portu (driveru USB-CAN prevodniku) v€etné jeho nastaveni.

e ExtCanPortDisconnect — tato funkce odpoji objekt ExtCanPort od
fyzického portu (driveru USB-CAN pievodniku).

e ExtCanPortSetData — odesle jeden ramec External Mode.

e ExtCanGetRawData — pfijme jeden ramec External Mode. Tento ramec se
mulze skladat z vice CAN zprav, tak ¢eka dokud nepfijme cely ramec

External Mode.

e ExtCanPortDataPending — tato funkce vraci poCet CAN zprav Cekajicich

na pfijem ze sbérnice CAN.

ext_can_pkt.c
Tento soubor je stejny pro stranu host i target. Soubor je popsan v kapitole 4.3.3.

Systém odesilani ramca External Mode

Popis ramcu External Mode pro CAN komunikacni vrstvu je popsano v kapitole
4.3.1.1. Tyto ramce jsou odesilany (pfijimany) pomoci CAN zprav, systém
odesilani je popsano v kapitole 4.3.2.2. S pouzitim USB-CAN pfevodniku
na strané hostu neni potfeba nastavovat v pfijimacim bufferu nastavovat ID zprav,
ukladany do fronty v pfevodniku a pomoci driveru je postupné &teme. Odesilaci

buffer je feSen podobné.

v v

ramec External Mode. Stejné je ramec External Mode odesilan pomoci CAN zprav

od ID 200. Nastaveni ID Cisla zpravy Ize zménit.

4.4.3. MEX-soubor

Matlab APl umoznuje interakci Matlabu s okolnimi aplikacemi (viz [11]). Matlab
API Ize také pouzit k vytvareni funkci pro Matlab napsanych v jazyku C, C++ nebo
Fortran (tzv. MEX-files) a tyto funkce nasledné jednoduse volat z Matlabu.

MEX- soubor obsahuje funkce, které se skladaji ze dvou &asti. Prvni, tzv. Gateway
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interface, zajistuje komunikaci s Matlabem a je obdobou funkce main() v jazyce C.
Druha cast je vlastni kod. Vyhodou mex funkci je jejich vyS$Si rychlost oproti

m- funkcim.

V External Mode tyto MEX-soubory obsahuji zdrojovy kod External Mode a
pFislusny zdrojovy kdéd pouzité komunikacni vrstvy. Popis zdrojovych soubor(
External Mode je popsano v kapitole 2.3.2. Na obrazku 9 jsou vidét obsazené Casti
MEX-souboru pro External Mode. Matlab (Simulink) dle zvoleného interface vola
rizny MEX-soubor, se kterym komunikuje prostfednictvim vstupni mex funkce
(mexFunction). Vybér nové komunikacni vrstvy (MEX-souboru) je popsan
(viz kapitola 4.4.4).

44.3.1 Tvorba MEX-souboru

MEX-soubor vznikne pfekladem a linkovanim zdrojovych soubort napsanych
v jazyce C, C++, Fortran pomoci funkce mex definované v Matlabu. Po spusténi

nasledujiciho pfikazu v pfikazové radce
mex -setup

muzeme vybrat nebo zménit preklada¢, ktery ma byt pouzit pfi tvorbé
MEX- souboru. Pfi praci byl pouzit pfeklada¢ Microsoft Visual C++ 2005, aby mohl
byt pouzit debug MEX-souboru (viz kapitola 4.4.3.6).

Pouziti mex funkce je nasleduijici:

mex -(mozZnosti nastaveni) -(nazvy souboru)

moznosti nastaveni — specifikuji hodnoty a proménné, které jsou dale predavany

ve formé argumentl prekladaci, linkeru a jinym nastrojom. Zde uvedu jen

argumenty, které byli pouzité pfi tvorbé MEX-souboru pro External Mode.

e -g - s timto parametrem je vytvofen MEX-soubor, ktery obsahuje pfidané
informace pro debugger. Pokud neni tento parametr pouzit, tak je defaulné

nastavena optimalizace koédu (volbou -0).
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e -I<cesta> - pfida cestu pro hledani hlavickovych souborl, které jsou

definovany ve zdrojovych souborech pomoci direktivy #include.

e -l<nazev> - pfidani knihovny funkci. Pfi pouziti na Windows je

z <nazev>, vytvofeno <nazev>.lib nebo lib<nazev>.lib.

e -L<directory> - pfida do seznamu cest, cestu ke knihoné specifikované

pfikazem -1.

e -output <nazev> - touto moznosti Ize vybrat nazev MEX-souboru a Ize

zadat cestu kam se ma soubor ulozit.

e -v — Verbose mdd. VypiSe v konzoli hodnoty dulezitych proménych,

vypiSe kazdy kompilacni krok a také koneény krok linkeru.

Nazvy soubord - soubory mohou byt kombinaci zdrojovych soubort, object

souborud a knihovnich souboru.

4.4.3.2 MEX-soubor pro sériovou podporu External Mode

MEX-soubor  vytvoreny pro sériovou komunikaci se  jmenuje
ext_serial_win32.mexw32. Tento soubor je ulozen % adresafi
matlabroot/toolbox/rtw/rtw/. Dale je uveden pfikaz pomoci néhoz muzeme vytvorit

MEX-soubor pro sériovou komunikaci RS-232:

mex rtw\ext_mode\common\ext_ comm.c rtw\ext_mode\common\ext _convert.c
rtw\ext_mode\serial\ext_serial _transport.c rtw\c\src\ext_mode\serial\
ext_serial_pkt.c rntw\c\src\ext mode\serial\ext_serial win32 port.c -Irtw
\c\src\ext_mode\common  -Irtw\c\src\ext_mode\serial -Irtw\ext_mode\common
-output toolbox\rtw\rtw\ext _serial_win32_comm -DWIN32

4.4.3.3 MEX-soubor pro CAN podporu External Mode

Byl vytvofen MEX-soubor s nazvem ext_can_systec.mexw32. Tento soubor je
potfeba ulozZit do adresafe matlabroot/toolbox/rtw/rtw/, aby mohl byt spustén
Matlabem (Simulinkem). Registrace vybéru komunikacni vrstvy (MEX-souboru)

popisuje kapitola 4.4.4.
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Pro tvorbu MEX-souboru byly pouzity soubory popsané v kapitole 4.4.2 a
knihovna funkci popsana v kapitole 4.4.1.3. Pfi tvorbé& MEX-souboru byl problém
pfi linkovani knihovny USB-CAN prevodniku s ostatnimi zdrojovymi soubory. Tento
problém nastal, pokud byla knihovna vkladana pomoci pfikazu -I<nazevknihovny>

a -L<adresar knihovny>.

mex  rtw\ext_mode\common\ext_comm.c ....zdrojové  soubory....-output
toolbox\rtw\rtw\ext_can_comm -DWIN32 -L rtw\ext_mode\can -IUSBCAN32

Problém byl odstranén pokud byla knihovna pfidana jako ostatni zdrojové
soubory, bez pouziti specialnich argumentl na pfidani knihovny. Pfiklad ukazuje
vytvofeni MEX-souboru, pokud byly vSechny zdrojové, hlavickové soubory a
knihovna umistény v jednom adresafi. Potom pfikaz pro vytvofeni MEX-souboru je

nasledujici:

mex ext_can_port.c ext_ comm.c ext_convert.c ext_can_transport.c ext_can_pkt.c
USBCAN32.lib -output 'C:\Program
Files\MATLAB\R2008a\toolbox\rtw\rtw\ext_can_systec' -DWIN32

Nasledujici pfikaz vytvofi MEX-soubor pro transportni vrstvu CAN, pokud jsou

zdrojové soubory External Mode uloZeny (viz tabulka 4).

mex rtw\ext_mode\common\ext_comm.c rtw\ext_mode\common\ext_convert.c
rtw\ext_mode\can\ext _can_transport.c rtw\c\src\ext_mode\can\ext can pkt.c
rtw\c\src\ext_mode\can\ext_can_port.c USBCAN32.1ib -Irtw
\c\src\ext_mode\common -Irtw\ext_mode\common -Irtw\c\src\ext_mode\can -Irtw
\ext_mode\can -output 'C:\Program
Files\MATLAB\R2008a\toolbox\rtw\rtw\ext_can_systec -DWIN32

Tento pfikaz je uloZen v souboru mex_can_systec.m.

4.4.3.4 Aktualizace soubort v Matlabu

Pokud je ulozen nebo zménén jakykoliv soubor v adresafi matlabroot/toolbox

nebo je pfidan nebo odebran soubor je nutné spustit v Matlabu funkci:

rehash toolbox
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Tato funkce nema zadné vstupni parametry a aktualizuje seznam adresaru a
soubort v matlabroot/toolbox. Porovna ¢asové stopy nahranych funkci s funkcemi,
které jsou uloZzeny na disku. Pokud jsou Casové stopy funkci na disku novéjsi, tak

Matlab aktualizuje svUj seznam funkci.

4.43.5 Vstupni parametry pro MEX-soubor transportni vrstvy
CAN

Nastaveni vstupnich parametrl MEX-souboru se nachazi v Tools->Real-Time
Workshop->Options->Configuration Parameters (viz obrazek 10). Zde muiuzeme
nastavit parametry, které jsou prfedany External mode interface MEX-souboru
(ext_can_systec). Pro CAN komunikaci Ize nastavit nasledujici parametry:

e Verbosity level - nastaveni urovné vypisu informaci, které jsou
vypisovany na konzoli v Matlabu béhem pfenosu. Lze nastavit
hodnotu 0 pro zadné informace nebo hodnotu 1 pro detailni vypis.

e ID zafizeni - Cislo pfipojeného USB-CAN pfevodniku
(viz obrazek 26).

e Prenosova rychlost — Ciselna hodnota pfenosové rychlosti, pro CAN
komunikaci je mozné nastavit (10, 20, 50, 100, 125, 250, 500, 800,
1000) kbit/s.

4.4.3.6 Debug MEX-soubort

Pokud je MEX-soubor vytvofen pomoci volby -g (viz kapitola 4.4.3.1) je mozny
debug MEX-souboru za pomoci zdrojovych soubor(, ze kterych byl MEX-soubor
vytvofen. Tim neni mozné spustit tento soubor na jiném pocitaci, protoze
MEX- soubor ma vazbu na zdrojové soubory z nichz byl vytvofen. Nasledné bude

popsan postup pro debug MEX-souboru v prostfedi Microsoft Visual Studio.

Ve vyvojovém prostifedi Microsoft Visual Studio je mozny debug MEX-souboru
pomoci vstupnich zdrojovych soubort MEX-souboru. Je mozné krokovat zdrojovy
kod, nastavovat breakpointy a sledovat proménné. Dale uvadim struCny popis

nastaveni:

e Vybér prekladaCe — pfi tvorbé MEX-souboru je nutné vybrat pfekladac
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Microsoft Visual C++ 2005. Tento vybér se provede napsanim do pfikazové

fadky v Matlabu pfikaz mex -setup, €im se vybere prekladac.

e Vytvofeni MEX-souboru — je nutné vytvofit MEX-soubor s volbou -g.
e Spustit Visual Studio — nesmi se zavirat Matlab okno.

e V menu ve Visual Studiu zvolit Tools -> Attach to Process.

e Z dialogového okna vybrat proces MATLAB a potvrdit Attach.

e Otevrit zdrojovy soubor pouzity v MEX-souboru volbou File -> Open ->
File.

e Nastaveni breakpointl — Ize provést pravym klikem mySi nebo z menu

Breakpoint -> Insert Breakpoint.

e Posledni krok spociva ve spusténi MEX-souboru v Matlabu.

4.4.4. Registrace transportni vrstvy v softwaru Simulinku

Transportni vrstva External Mode se vybira pro model v Simulinku v zalozce
Tools -> RealTime Workshop -> Options, tento vybér je mozné vidét na obrazku
28. Zména je nutna proveést pro Target, podle néhoz je generovan zdrojovy kéd
v modelu (viz kapitola 2.1.1.1). Registraci je mozné provést pro uzivatelské

Targety nebo Targety podporované firmou MathWorks.

Pro Targety podporované firmou MathWorks se registrace nové transportni
vrstvy provadi v souboru
matlabroot/toolbox/simulink/simulink/extmode_transports.m. Tento soubor je
uloZen (viz tabulka 4). P¥i praci byl pouzivan Target ERT, ktery podporuje External
Mode pro ukazku uvadim pfiklad registrace nové transportni vrstvy do tohoto

Targetu (zmény jsou podtrZzeny).
ERT Target

strcmp(sysTargFile, 'ert.tic');
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transports = {
"tcpip 1’

'serial_win32'

mexfiles = {

'ext_comm’,

% Index 0 in the template makefiles
% Index 1

can' % Index 2

% MEX-File for 'tcpip’

'ext_serial_win32_comm', % MEX-File for 'serial_win32'

'ext_can_systec'

)

% MEX-File for 'can'
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ert.tlc — je jméno Targetu, do kterého je nova komunikacni vrstva registrovana

transport — je jméno komunikacCni vrstvy, které je zobrazované v nastaveni

Transport layer v panelu Configuration Parameters -> Interface. Zobrazeni pro

komunikacni vrstvu CAN je mozné vidét na obrazku 28.

mexfile — je jméno MEX- souboru vytvofeného pro konkrétni komunikaéni
vrstvu. Tento nazev je zobrazovan vedle nazvu transportni vrstvy v nastaveni

Transport layer (viz obrazek 28).

#, Configuration Parameters: pokus, Configuration (Active) x|
ey ] |
- Type Conversion — Code inkerfac d
- Conneckivity
- Compatibility ™ &RT compatible callinterface W Single outputfupdate Function W Terminate function required
~Model Referencing ™ Generate reusable code
- 5aving
- Hardware Implementation I™ Suppress error status in real-time madel data struckure
~Model Referencing Configure Step Function
[=]-Real-Time Warkshop
- Repark — verification
- Comments ) .
- Syrobols Support software-in-the-loop {SIL) testing
- Custom Code I~ Create Simulink {S-Function) black ™ Enable portable word sizes
- Debug
- Interface I~ MaT-file logging
- Code Style
- Templates —Data exchang
--Data Placement
- Data Type Replacement Interface: IExternaI mode =]
- Memory Sections Host/Target intetfac
[=-HDL Coder
- Global Settings Transport layer: can ['+] MES-file: name: ext_can_comm
-~ Test Bench MEX-file arguments: fCPR
~EDA Tool Scripts serial_win32
MEmary Managemen i I
’7|_ Static memary allocation ‘ ﬂ
J- OK I Cancel | Help | Apply |

Obrazek 28: Vybér transportni vrstvy CAN v nastaveni
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4.4.5. Demonstraéni uloha a testovani vykonovych
parametru

Byla vytvofena demonstracni uloha pro External Mode s pfenosem pomoci
CAN komunikace. Popis potfebnych zmén pfi portovani na mikrokontrolér
56F8367 byly popsany v kapitole 3 a také v kapitole 4.3. Tabulka 4 zobrazuje
prehled zdrojovych souboru, které musely byt modifikovany. Zdrojové soubory
External Mode i modelu v&etné PE projektu jsou ulozeny na pfilozeném CD

v adresafi external_mode\can.

Target

ext SVr.c Tyto soubory je nutné prehrat misto soubora, které
- jsou ulozeny v

updown.c matlabroot\rtw\c\src\ext_ mode\common

ext_svr_can_transp.c  Tyto soubory je nutné nahrat do adresare can,

ext_can_pkt.c ktery se vytvofi v adresafi

ext_can_PE_port.c matlabroot\rtw\c\src\ext_mode

Host

ext_can_transport.c Tyto soubory je nutné nahrat do adresafe can,
ext_can_utils.c ktery se wytvofi v adresafi

ext_can_port.c matlabroot\rtw\ext_mode

Tento m-file obsahuje pfikaz pro vytvofeni MEX-
souboru ext_can_systec

Soubor obsahujici registraci komunikaéni vrstvy v
extmode_transports.m |Simulinku, tento soubor je potfeba nahrat do
adresare matlabroot/toolbox/simulink/simulink/
Tabulka 4: Modifikované soubory External Mode pro CAN

mex_can_systec.m

4.4.5.1 Demonstraéni uloha

Byla vytvofena demonstracni uloha, aby ukazala pouZiti vysledného feSeni
realizace External Mode s komunikaci po sbérnici CAN na praktickém pfikladu.
Dale poskytuje navod vedouci k vytvoreni prikladu, ktery je sepsan proto, aby
slouzil pro lidi, ktefi budou tuto praci vyuzivat. Také mulze byt jako zdroj pro
vyjasnéni nesrovnalosti, které mohou vzniknout nedostateCnym prostudovanim

problematiky. Téd budou postupné popsany kroky, teré je nutné udélat, aby byla
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uspésne spusténa demostracni uloha:

Host (Simulink)
1. Instalace USB-CAN pievodniku (viz kapitola 4.4.1).

2. Upravené zdrojové soubory External Mode (viz kapitola 4.4.2) nahrat
do adresaru dle tabulky 4.

3. Vytvofeni MEX-souboru (viz kapitola 4.4.3.1), pfikaz je také uloZen na
pfilozeném CD v adresafi external_mode\can\mex v m-file souboru
mex_can_systec.m. Tento pfikaz je nutné spustit v pfikazovém fadku
Matlabu.

4. Registrace transportni vrstyy CAN do softwaru Simulinku
(viz kapitola 4.4.4).

5. Spusténi demo modelu s nazvem pokususb.mdl, ktery je uloZen
v adresafi external_mode\can\model.

e Vvybér simulaéniho modu (viz kapitola 2.2.1)

e nastaveni zvoleného Interface- External mode v nastaveni
vokné modelu Tools->Real-Time  Workshop->Options-
>Configuration  Parameters, vybér transportni vrstvy
(viz obrazek 28) a nastaveni MEX parametrl
(viz kapitola 4.4.3.5)

e nastaveni kroku simulace Fixed Step s definovanou periodou
a nastaveni zvoleného Targetu (napf. ERT)

e generovani kédu z modelu

Target (MCU)

1. Upravené zdrojové soubory External Mode nahrat do adresaft dle
tabulky 4.

2. Spustit projekt v Metrowerks Code Warrior, demonstracéni projekt se
jménem external_ mode.mcp je ulozen na CD v adresafi
external_mode\can\PE\external_mode_can.

e nastaveni FreescaleCAN portu na MCU

e nastaveni cesty k zdrojovym souborim vygenerovaného
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modelu nebo prekontrolovani cest k ostatnim pouzitym
zdrojovych souborl, pfipadné nastaveni jejich cesty pomoci
access paths toto nastaveni je popsano v kapitole 4.3.2

e nastaveni pfiznaku EXT_MODE % preprocesoru
(viz kapitola 3.2.1.5)

e nasleduje prelozeni projektu pomoci make a spusténi

Target je spustén, ale ¢eka na startovaci ramec od Simulinku. Popis spusténi a

ovladani simulace v Simulinku je popsana (viz kapitola 2.2).
4.4.5.2 Testovani vykonovych parametru

Testovani vykonovych parametrd External Mode s komunikaci po sbérnici CAN
bylo porovnavano se sériovou komunikaci RS-232. V Simulinku byl vytvoren
model sestaveny z jednotlivych bloku, které charakterizuji regulacni algoritmus.
Dale byly pfidany monitorovaci bloky (Scope), pomoci kterych Ize sledovat signaly

mezi libovolnymi bloky modelu.

Pribéh komunikace mezi Simulinkem a targetem je popsan v kapitole 2.4.3.3 a
je ho mozné vidét na obrazku 15. Pokud je pfi inicializaci nastaven upload
zvolenych signalu je po odeslani odpovédi (EXT_MODEL_START_RESPONSE)
spustén podle nastavené periody vypocet signald modelu. Hodnoty jednotlivych
signalu jsou ukladany do paméti a nasledné odesilany smérem k Simulinku dle

moznosti komunikaéniho kanalu.

Testovani vykonovych parametrd bylo provedeno pro pfipad, kdy Simulink
neodesila zadné zadosti na target (EXT_SETPARAM) pouze zasila Zadosti o
aktualni Cas simulace (EXT_GET _TIME). Target odesila upload ramec
(EXT_UPLOAD_LOGGING _DATA) s hodnotami jednotlivych signala. Zakladni
délka tohoto ramce pro prenos jedneho vypoclteného signalu je 41B
(pro sériovou komunikaci) pro CAN komunikaéni vrstvu byl upraven na délku 40B
(viz kapitola 4.3.1.1), aby tento ramec mohl byt odeslan pomoci péti CAN zprav.
Dals$i modifikace ramcu pro komunikaéni vrstvu CAN je popsano

(viz kapitola 4.3.1.1). S kazdym dal$im signalem se ramec zvétSuje o 4B.
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Tabulka 5 ukazuje dosazené maximalni vzorkovaci periody (krok vypoctu
modelu) pro komunikaci po sbérnici CAN (1Mbit/s) a sériovou linku RS-232
(57 600 bit/s). Test byl proveden s proménym poctem prenasenych signalu (int32).

Maximalni krok wpoc¢tu modelu
Pocet pfenasenych RS-232 CAN
signall T [ms] T [ms]
1 9,1 0,7
2 10 0,78
3 10,9 0,81
4 12 0,89
5 13,1 0,92

Tabulka 5: Porovnani vykonovych parametri
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5 Moznosti pouziti JTAG/ONCE
komunikace

V této kapitole budou teoreticky popsany moznosti pouziti JTAG/OnCE pro
External Mode. Poznatky v této kapitole slouzi pro informativni pfehled, jakym

smérem by mohla pokraCovat podpora External Mode.

Joint Test Action Group (JTAG) je nazev, ktery vznikl z ptvodniho ucelu pro
testovani desek ploSnych spoju pomoci boundary scanu. Pozdéji normalizované
jako IEEE 1149.1 Standard Test Access Port and Boundary-Scan Architecture
(viz [12]).

JTAG se dnes Siroce pouziva pro ladici ucely integrovanych obvodu. Mnoho
vestavénych procesoru na trhu podporuji JTAG, kdyz maiji dostatek pinu. Debug
programy komunikuji s Cipy prostfednictvim JTAG a umozniuji provadét krokovani
programu nebo vkladani breakpoint(. Dale se pouziva pro produkty, které nemaiji

jinou sbérnici pro nahrani programu a ladéni.

69



KAPITOLA 5 70

5.1 JTAG/OnCE pro Freescale 56F800

Toto rozhrani umoznuje zapis a Cteni flash paméti jednotek procesoru pomoci

JTAG/OnCE rozhrani. Toto rozhrani obsahuje dva moduly:
e OnCE (On-Chip Emulation) modul pro emulaci
e JTAG konektor (nazyvan jako Test access port (TAP) )

Toto rozhrani umozniuje nahrani programu véetné funkci pro debug. To je
vyhodou, protoZze neni nutné kupovat drahy kabel, ktery umoznuje funkce

emulace, vice informaci (viz [13]).

5.1.1. JTAG

K JTAG rozhrani je vyhrazen pfistup pomoci péti pint. Zakladem je TAP
controller, ktery obsahuje 16-stavovy automat. Instrukénim dekodérem je
dekddovana instrukce, ktera je nasledné vykonavana. Freescalle implementoval
OnCE rozhrani (OnCE module) pro debug aplikace. Schéma JTAG rozhrani je

mozné vidét na obrazku 29.

input MUX onCE output MUX
Module

/ ID Register -\
*

TDI -
o Eumdary Scar |
- -
Decoder
™S s T
TAP
TCK —I— Controller
TRST
TDO

Obrazek 29: JTAG

JTAG (TAP) vykonava nejcastéji nasledujici funkce:
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e posun instrukce dovnitf a ven a nasledné dekodovani
e pfijem a vysilani dat
e zapis do JTAG/OnCE registra

JTAG piny

Ve specifikaci rozhrani JTAG je definovan minimalni pocet signall. Je potifeba
minimalné ¢&tyfi signaly TDI, TDO, TCK a TMS.
e TDI - vstup sériového datového toku do JTAG a OnCE modulu.
e TDO - vystup sériového datového toku do JTAG a OnCE modulu.
e TMS - vstupni sekvence dat pro funkci TAP stavového automatu.
e TCK - signal hodin pro posun dat, maximalni frekvence pro TCK je 1/8

maximalni frekvence pro 56F80x (tj. 5MHz pro sbérnici procesoru 40MHz).

Casovani JTAG signalil je mozné vidét na obrazku 30. Pfi sestupné hrané
na TCK je aktualizovana hodnota na TDO. Pro TDla TMS je vzorkovana hodnota

pfi nabézné hrané.

TCK -.Iﬁ\ll
TDO k‘\{ output data valid
TDI & TDS { inputdatavalid ——

Obrézek 30: JTAG signal

JTAG vykonava posledni pfijatou instrukci (TAP controlerem) dokud neni pfijata
a zpracovana nova instrukce (napf. instrukce pfijem a ukladani dat). Pokud se

pfijima instrukce na pinu TDI, tak na pin TDO je vysilan informacni stav.

Prenos dat z a od JTAGuU

Pfenos dat je spojen s vykonavanim instrukce. Data se posunuji z a do JTAG
registri nebo do OnCE modulu. Typ (adresa registru) a délka datového registru

zavisi na druhu instrukce.
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5.1.2. OnCE modul

OnCE modul byl navrhnut pro ladéni aplikacniho sotwaru. Tento blok je
samostatny a pfistup k nému je mozny prostfenictvim pint JTAG rozhrani. Modul
OnCE umoznuje sledovat a ménit hodnoty registri, paméti a periferii, které jsou

na Cipu.

Freescale ma OnCE (On-Chip Emulation), ktery je mozné spustit ve specialnim
rezimu pomuci specialni instrukci v TAP stavovém automatu. OnCE instrukéni
registr drzi ladéni pfikaz( pro operace, jako je krok programu, breakpoint a pfistup

Kk registrim a paméti.

Pro vstoupeni (propojeni dat) do OnCE modulu musi byt TAP stavovym
automatem vykonavana instrukce ENABLE ONCE, tim je JTAG modul master a
povoluje spojeni. OnNCE modul poskytuje plnou rychlost, nepferuSsovanou emulaci
a debug. OnCE modul ma implementovany vlastni stavovy automat. OnCE modul
ma definovany dva typy pfikazu zapis (Cteni) instrukci a dat. V debug mddu je
mozné zapisovat a Cist data na adresu registru, ktera je definovana pro zapis
(OPDBR) a pro ¢teni (OPGDBR).

5.2 JTAG pro External Mode

5.2.1. Porovnani komunikacnich protokolu

V této kapitole budou porovnany zakladni viastnosti jednotlivych komunikacnich

protokoli moznych pro External Mode (viz tabulka 6).
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Komunikaéni protokol + klady - zapory
Sériové linka RS-232 + jeqnoduché implementace . - nizka "yvahPSt pfenosu
+ podporovana externim médem pro win32 - zatézuje MCU
TCPIIP + podporovan extemim médem pro Win. i Linux | nutny prevol\ﬁ glﬁ)(pro neéktere
- zatézuje MCU
+ pfenosova rychlost - zatézuje MCU
+ dostupny pfevodnik (napf. USB-CAN etné
CAN oviadacu)
+ mozné pouZit na stavajici sbémici
+ vice CAN portli na MCU
+ wsoka pfenosova rychlost - zatézuje MCU
+ jednotucha implementace - casto nejsou wwedeny piny
SPI nebo jsou obsazeny
+ master - slave komunikace host(klient) mize - nutny pievodnik (USB-
byt Master SPI,Ethernet-SPI)
- méné pouzivany nez CAN
+ nazatézuje MCU - slozita implementace
JTAG + wsoka pfenosova rychlost - nutny prevodnik
+ standartni interface pro MCU

Tabulka 6: Komunikacni protokoly pro External Mode

5.2.2. Podpora JTAG/OnCE hardwaru

Existuje cela fada JTAG hardwaru pro ucely, jako je vyroba, testovani, ladéni
vysokorychlostnich systémd nebo vyvoj mikrokontrolérl. JTAG je vétSinou

pouzivan vyvojafi softwaru pro ladéni a aktualizace firmware.

Na trhu jsou dostupné USB-JTAG/OnCE prevodniky pro mikrokontrolér
Freescale fady 56Fxxx. Prvni je pfimo od Freescale vice v literatufe[14], ale nikde
v informacich jsem nenasel, Ze by tento pfevodnik byl dodavan s driverem. Druhy
USB-JTAG/OnCE prevodnik (viz [15]) nabizi i drivery pro praci s timto

prevodnikem.

Pro pouziti JTAGu pro External Mode je nutné vzdy realizovat rozhrani mezi
komunikaénim protokolem z PC a JTAG/OnCE. Pro External Mode , proto uvadim

nasledujici moznosti:

e USB-JTAG/OnCE
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o mozno koupit pfevodnik, nevyhoda vysoka cena a nejista podpora

ovladacu

o vytvorfit vlastni pfevodnik, nutnost vytvofit podporu ovladacd, nutna

implementace podpory pro host
e Eternet-JTAG/OnCE

o nutnost vytvofit pfevodnik, vyhoda - External Mode podporuje TCP/IP

5.2.3. Host

Pokud bude vybrana koncepce rozhrani Ethernet-JTAG/OnCE, tak stranu host
External Mode nebude potieba modifikovat. V pfipadé koncepce USB- TAG/OnCE
se bude muset vytvofit podpora komunikacniho protokolu pro host. Tato zména

komunikaéniho protokolu je popsana v kapitole 4.4 pro podporu CAN sbérnice.

5.2.4. Target

Implementace podpory na strané targetu pro sériovou linku jsou popsany
v kapitole 3 nebo pro komunikaci prostfednictvim sbérnice CAN v kapitole 4.4.
Dulezitd zména bude v implementaci funkci komunikacni vrstvy (viz obrazek 11).
Tyto funkce nebudou pfistupovat k fyzickému portu, ale k paméti kam se budou
ukladat ramce s daty. External Mode je zalozen na klient/server architektufe, kde
klient je host. Tim host bude odesilat (zapisovat data do paméti) na target a

zaroven Cist (data z paméti), coz umoZuje pfenos JTAG (viz obrazek 30).

DalSi moznosti je zjiSténi z targetu na jaké adrese jsou ukladany hodnoty
proménych. Pomoci JTAG/OnCE rozhrani potom pfimo pfistupovat do paméti a

Cist pfimo tyto hodnoty.
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6 Zaver

Tato diplomova prace se zabyva podporou External Mode v mikrokontrolérech.
External Mode se vyuziva pfi navrhu fidiciho algoritmu, kdy je mozné navrh

fidiciho algoritmu testovat na cilovém hardwaru, pro ktery je fidici systém vyvijen.

Kod fidiciho algoritmu je spustén na cilovém mikrokontroléru. Prostfednictvim
komunika¢niho kanalu External Mode jsou vypocltena data pfenasena mezi
modelem v Simulinku a mikrokontrolérem v realném Case. Diky External Mode
muzeme v Simulinku tyto data zobrazovat. Z prostifedi Simulinku je mozné ovladat
spousténi, ménit parametry blokii modelu a nastavovat parametry v modelu na

mikrokontroléru a to vSe za béhu vykonavani algoritmu.

V uvodu prace byly prostudovany moznosti vyuziti External Mode pro
mikrokontroléry (MCU) v€etné automatického generovani kdédu z modelu za
pomoci nastroje Real-Time Workshop (RTW). Dale byla prostudovana
klient/server architektura External Mode a komunikaéni protokol, ktery bude vyuzit

pfi implementaci podpory nové komunikacni vrstvy.

75
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Nasledné byla naportovana podpora External Mode na mikrokontrolér
Freescale 56F8367 prostfednictvim podporované sériové komunikace RS-232. .
Tato ¢ast obsahuje zmény souvisejici s pouzitim External Mode na 16 bitovém
mikrokontroléru 56F8367. Pfi praci se zmifiovanym mikrokontrolérem byl pouZit

nastroj Processor Expert, ktery vyrazné urychluje vyvoj vestavénych aplikaci.

Hlavnim cilem prace bylo implementovat podporu External Mode s komunikaci
po sbérnici CAN. Tato ¢ast obsahuje impementaci podpory komunikacni vrstvy na
strané host (Simulink) i target (MCU). Na strané Simulinku byl pouzit pfevodnik
USB-CAN prostfednictvim jeho driveru komunikujeme se sbérnici CAN. Nasledné
byl vytvofen MEX-soubor pro tuto komunikacni vrstvu CAN prostfednictvim néhoz
Matlab umoziuje interakci s okolnimi aplikacemi a potom byla zaregistrovana
CAN komunikacni vrstva v softwaru Simulinku. Na strané targetu byla
implementovana podpora komunikacni vrstvy CAN sbérnice. Také byla upravena
struktura ramce External Mode pro sbérnici CAN, aby nedochazelo
k pfebyte€nému pfenosu zprav, které neobsahuji uziteCnou informaci. V zavéru
této Casti byly ovéfeny vykonové parametry pfi pouziti sbérnice CAN oproti sériové

komunikaci.

V zavéru prace byly teoreticky popsany moznosti pouziti JTAG/OnCE pro
External Mode. V této Casti jsou také porovnany vyhody a nevyhody jednotlivych

komunikacnich vrstev pro External Mode.

Vysledné feSeni umoziiuje vygenerovat fidici algoritmus z modelu v Simulinku
a spustit ho v mikrokontroléru. S pouzitim External Mode s komunikaci po sbérnici
CAN muzeme monitorovat vypocet fidiciho algoritmu na MCU s periodou vypoctu
modelu 700us a vysledky zobrazovat v Simulinku v realném ¢€ase. Tuto podporu
Ize vyuzit pfi jakémkoliv druhu simulace, pfi kterém je Fidici algoritmus spustén na

fyzickém hardwaru.
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Priloha A

Obsah prilozeného CD

K této praci je pfilozeno CD, na kterém jsou uloZeny zdrojové soubory.
Adresarova struktura je nasleduijici.

e ./ doc — tato diplomova prace ve formatu pdf
e ./src
o [/ serial — tento adresar obsahuje zdrojové soubory External Mode, PE
projektu a demonstracni ulohy pro komunikaci v External Mode
prostfednictvim sériové komunikace RS-232
o /can -tento adresaf obsahuje zdrojové soubory External Mode, PE
projektu a demonstracni ulohy pro komunikaci v External Mode
prostfednictvim sbérnice CAN
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